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PREFACE

General 

Commissioning is the first step after the installation of the CIU 888.
During commissioning, the CIU 888 site configuration is created and
site elements such as CIU, field ports, tanks, GPU data inputs, Modbus
data inputs, TRL/2 data input, and host ports are configured. 

When the site is in operation and there are changes, for example a
gauge is added or an additional host system is connected, these
changes need to be implemented, and the CIU 888 needs to be
updated with the new site configuration.

Purpose of this manual

The purpose of this manual is to provide information about the
commissioning and configuration of the CIU 888.For the migration of an
existing CIU 880 Prime/Plus site configuration to the CIU 888, See
chapter 3.2.4 "Ensite pro database import option".

Target audience of this manual

This manual is primarily intended for service technicians who are
responsible for commissioning and configuration of the CIU 888. 
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CHAPTER 1 INTRODUCTION 

The CIU 888 Service Tool is used for commissioning and configuration
of the CIU 888. The CIU 888 Service Tool is typically installed on a PC/
laptop running Windows 10, which in turn is connected to the CIU 888
via the Service port located at the front of the CIU 888 or VPN port
located at the back of the CIU 888.

CIU 888 Service Tool replaces Ensite Pro as the configuration tool for 
CIU 888. The CIU 888 Service Tool provides the Ensite Pro 
configuration options with the following improvements:

 Support for a maximum of 80 tanks.
 Support for a maximum of 6 field ports.
 Support for a maximum of 6 host ports.
 Support for gauge engineering units.
 Support for configuring a maximum of 4 host ports for GPU

emulation and Modbus Emulation
 Support for Modbus field scan.
 Support for TRL/2 field scan.
 Support for servicing of Rex gauges.
 Support for Modbus TCP/IP on host ethernet ports.
 Support for OPC UA TCP on host ethernet ports.
 Support for Wireless field device scan on field ethernet port.

NOTE: CIU 888 Service Tool can be released independent of CIU 888 firmware, hence
the CIU 888 Service Tool has its own release number independent of CIU 888
firmware release number.

1.1 When to use CIU 888 Service Tool

From CIU 888 R103 release, CIU 888 Service Tool is being introduced
to configure CIU 888. 

Until R103 release, Ensite Pro, Ensite Pro to CIU 888 Migration Tool,
and Web interface are used during commissioning/configuration of the
CIU 888. 

The Migration tool is used for uploading the site configuration to the CIU
888 and for updating the INI files generated from Entis Pro. INI files are
configuration files for Entis Pro. Migration tool needs to update the INI
files before the files can be loaded to the Entis Pro tank inventory
system.
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The applicable configuration tools and scenarios to configure CIU 888
are mentioned in the following table.

NOTE: For Ensite pro database See chapter 3.2.4 "Ensite pro database import
option".

1.1.1 CIU 888 and Service Tool Compatibility Matrix

1.2 Recommended workflows to commission CIU 888

This section gives details on how to commission a CIU 888 (both
redundant and non-redundant), and how to update the site configuration
details of an existing CIU 888.

Use Ensite Pro + Migration tool + Web 
interface Use CIU 888 Service Tool

Supported scenarios:
 CIU 880 being replaced by CIU 888, 

except 4 plus host ports in redundant 
non cross hot standby configuration.

 Earlier units of CIU 888 being 
replaced with new units of CIU 888.

Supported scenarios:
 CIU 880 being replaced by CIU 888 

with 4 plus host ports in redundant 
non cross hot standby configuration 
(new configuration).

 New sites being commissioned for 
CIU 888.

 CIU880 Migrations through Ensite 
Pro database import

CIU 888 Version Service Tool Version
R103.1/R103.2 Service Tool R101.1

R120.1 Service Tool R120.1

R120.2 Service Tool R120.2

R130.1 Service Tool R130.1

R140 Service Tool R140

R150 Service Tool R150

R160 Service Tool R160

R161 Service Tool R161

R162 Service Tool R162

R210 Service Tool R210
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1.2.1 Commissioning a CIU 888 Standalone system

FIGURE  1-1 Commissioning a Standalone System Setup

Notes: 1. Step 3 can be done offline without connection to CIU 888 and is 
independent of step 1 and 2. 

2. Steps 5 and 6 are required only when Entis Pro is a host connecting to 
CIU 888.
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1.2.2 Commissioning a CIU 888 Redundant system 

FIGURE  1-2 Commissioning of a Redundant System Setup

Notes: 1. Step 3 can be done offline without connection to CIU 888 and is 
independent of step 1 and 2.

2. Step 6 is required only when Entis Pro is a host connecting to CIU 888.
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1.2.3 Updating Non Redundant CIU 888 Configuration 

FIGURE  1-3 Updating Non redundant CIU 888 Configuration

NOTE: Steps 3 and 4 are required only when Entis Pro is a host connecting to 
CIU 888.
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1.2.4 Updating Redundant CIU 888s Configuration

FIGURE  1-4 Updating Redundant CIU 888s Configuration

Notes: 1. Steps 3 and 4 are required only when Entis Pro is a host connecting to 
CIU 888.

2. Primary CIU 888 & Secondary CIU 888 must be in sync.

3. Entis pro should be shut down before sending the site configuration to 
CIU 888.

4. Updates can be sent only to primary CIU 888 and not to secondary CIU 
888.
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CHAPTER 2 INSTALLING CIU 888 SERVICE TOOL

2.1 Prerequisites

The PC/laptop must meet the following requirements to install the CIU
888 Service Tool:

 Windows 10 Enterprise 64 bit or Windows 10 LTSB 64 bit
 Microsoft .NET Framework 4.0 or higher

NOTE: Microsoft .NET Framework 4.0 is installed automatically during the installation
of Windows 7 or Windows 10.

 Minimum 4 GB RAM
 Microsoft Internet Explorer 10.x or 11.x or Google Chrome (version

66 or above).
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2.2 Installing CIU 888 Service Tool

2.2.1 Installing CIU 888 Service Tool on the new machine
1. Right-click on Setup file and then click Run as administrator.

The welcome to installShield Wizard appears:.

2. Click Next.
The License Agreement window appears:

3. Read all license agreement and select “I accept the terms in the
license agreement” .

4. Click Next.
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The Ready to Install the Program window appears:

5. Click Install.
6. The Installing Honeywell CIU 888 Service Tool R210 installation

progress status window appears:
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7. The InstallShield Wizard Completed window appears after
successfull installation:

NOTE: The "Local Engineers" group will be created by default and the current user will
be added to the "Local Engineers" group.

8. Click Finish to close the wizard.
9. The message box appears to logoff and login the machine.

NOTE: If the local engineers group is already existing in the machine and if the current
user is already associated with the local engineers group, the message box
may not appear to logoff and login the machine.

10.Click Yes for installation changes to be effective.
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2.2.2 Upgrade the Installer
1. Right-click on Setup file and then click Run as administrator.

The welcome to installShield Wizard appears:.

2. Click Next.
The License Agreement window appears:

3. Read all license agreement and select “I accept the terms in the
license agreement”.

4. Click Next.
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The Select Installation Option window appaers:

5. Select Upgrade the existing CIU 888 Service Tool to uninstall the
previous version and install the new version.

The dialogue box appears to give message on the selected option.

6. Click Yes.

NOTE: This option removes the previous installation and then installs the new service
tool.
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The Ready to Install the Program window appears:

7. Click Install.
8. The Installing Honeywell CIU 888 Service Tool R210 installation

progress status window appears:
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9. The InstallShield Wizard Completed window appears after
successfull installation:

NOTE: The "Local Engineers" group will be created by default and the current user will
be added to the "Local Engineers" group.

10.Click Finish to close the wizard.
11.The message box appears to logoff and login to the machine.

NOTE: If the local engineers group is already existing in the machine and if the current
user is already associated with the local engineers group, the message box
may not appear to logoff and login the machine.

12.Click Yes for installation changes to be effective.
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2.2.3 Side by Side Installation
1. Right-click on Setup file and then click Run as administrator.

The welcome to installShield Wizard appears:.

2. Click Next.
The License Agreement window appears:

3. Read all license agreement and select “I accept the terms in the
license agreement”.

4. Click Next.
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The Select Installation Option window appears:

5. Select Install Honeywell CIU 888 Service Tool R210 to install the
R210 version.

NOTE: This option installs the new version of CIU 888 Service Tool without interrupting
older version. This is mainly designed to support multiple versions of CIU 888.
Hence the user will be able to see two versions of CIU 888 Service Tool.

The Ready to Install the Program window appears:

6. Click Install.
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7. The Installing Honeywell CIU 888 Service Tool R210 installation
progress status window appears:

8. The InstallShield Wizard Completed window appears after 
successfull installation:

NOTE: The "Local Engineers" group will be created by default and the current user will
be added to the "Local Engineers" group.

9. Click Finish to close the wizard.
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10.The message box appears to logoff and login to the machine.

NOTE: If the local engineers group is already existing in the machine and if the current
user is already associated with the local engineers group, the message box
may not appear to logoff and login the machine.

11.Click Yes for installation changes to be effective.
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2.3 Post-Installation

It is recommended to disable fast user switching.

2.3.1 Add User’s to “Local Engineers” Window Group

CIU 888 Service Tool shall be launched only if the user is part of "Local
Engineers" group. By default the installing user shall be added to this
group.

Users needing access to CIU 888 Service Tool should be added to this
windows group using "Manage Users and Groups" program of
Windows.

2.3.2 Importing old site databases using CIU 888 Service Tool R210

From CIU 888 Service Tool Rxxx, the site database is stored in the
release specific location. Hence requires to import the old site database
from its previous location, which in turn shall be stored in the specific
location C:\Users\Public\Documents\Honeywell\CIU 888 Service Tool
R210\SiteDatabase.
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2.4 CIU 888 Service Tool License

CIU 888 Service Tool license is generated based on the MAC address
of the PC/Laptop where it will be used. To obtain a Service Tool license,
you must send the MAC address and the general information of the PC/
Laptop (where the CIU 888 Service Tool is installed) to Honeywell
GTAC.

NOTE 1: This procedure would take a minimum of 2-3 days. Please plan for the same,
so that you have the license ready before you begin the commissioning
process.

NOTE 2: CIU 888 Service Tool R150 license has a new encryption algorithm. Hence CIU
888 Service Tool needs a new License to be requested. Existing machines
which already have Service Tool R101.1 also need to request for the new
license using the above mentioned procedure.

Once you have received the license file, complete these steps to install
the license file.

1. Click  (Start) > All Programs > Honeywell > Configuration >
CIU 888 Service Tool. The Browse For Folder window appears.

2. Browse to the license file received from the factory. Click OK.
3. CIU 888 Service Tool validates the license and starts the 

application.

NOTE: Once the license is validated, the same license file will be read automatically
for subsequent usage.
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2.5 Uninstalling CIU 888 Service Tool

1. Click  (Start) > Control Panel > Programs > Programs and
Features > Uninstall or change a program.

Select Honeywell CIU 888 Service Tool, right-click and choose
Uninstall.

2. A confirmation message appears.

Click Yes.
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CHAPTER 3 GETTING STARTED

The CIU 888 Service Tool is used for commissioning and configuring
CIU 888. The CIU 888 Service Tool is typically installed on a PC/laptop
running Windows 10, which in turn is connected to the CIU 888 via the
Service port located at the front of the CIU 888 (see FIGURE 3-1). 

FIGURE  3-1 CIU 888: Service port

FIGURE 3-2 shows a graphical overview of the CIU 888 Service Tool
and the CIU 888. 

FIGURE  3-2 Graphic overview of the CIU 888 Service Tool and the CIU 888
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3.1 CIU 888 Web interface

The CIU 888 Web interface provides access to these functionalities:

 View the relevant LM and non-LM configuration settings of the
CIU 888

 Display the system status, for example, the role of the CIU 888 in a
redundant system setup, the status of the W&M lock key switch and
the configuration lock key switch

 View system hardware diagnostics, for example, CIU 888 system
status, Field port communication status, CIU version, and so on

 View audit and event records logged by CIU 888
 Install firmware upgrades
 Update the CIU 888 license

To view the CIU 888 web interface, it is recommended to have a PC
screen resolution of 1280 x 1024 or higher.

The CIU 888 Web interface can be accessed using a standard browser,
refer to section 2.1 for supported browsers.

3.1.1 Changing the settings of Internet Explorer

To access the CIU 888 using Internet Explorer 10 or 11, the following
changes in the browser settings must be implemented:

1. Launch Internet Explorer.
2. Disable compatibility mode:

a) From the Tools menu, select the Compatibility View settings
option.
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The Compatibility View Settings window is displayed (see FIGURE
3-3). 

FIGURE  3-3 Compatibility View Settings window 

b) De-select (uncheck) all check boxes.
c) Click the Close button to close the window.

REMARK: Make sure you do not add the CIU 888 website to the compatibility view.

3. Add the CIU 888 website to the trusted sites.
a) From the Tools menu, select the Internet Options option.

The Internet Options window is displayed (see FIGURE 3-4). 
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b) Go to the Security tab. 

FIGURE  3-4 Internet Options window - Security tab

c) Click the Trusted Sites icon.
d) Click the Sites button.

The Trusted sites window is displayed (see FIGURE 3-5). 

FIGURE  3-5 Trusted sites window
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e) In the Add this website to the zone text box enter the IP address
of the CIU 888 website (i.e. https://192.168.1.1). Next, click the
Add button. 
The IP address of the CIU 888 is added to the trusted sites and is
displayed under Websites (see FIGURE 3-6). 

FIGURE  3-6 Trusted sites window - CIU 888 website added to Trusted sites zone

f) Click the Close button to close the window.
You will go back to the Internet Options window.

g) Click OK to save the settings and to close the window.
4. Enable the “Initialize and script ActiveX controls not marked as safe

for scripting” setting:
a) From the Tools menu, select the Internet Options option.

The Internet Options window is displayed (see FIGURE 3-4). 
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b) Go to the Security tab. 

FIGURE  3-7 Internet Options window - Security tab

c) Click the Trusted Sites icon.
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d) Click the Custom level... button.
The Security Settings - Trusted Sites Zone window is displayed
(see FIGURE 3-8). 

FIGURE  3-8 Security Settings - Trusted Sites Zone window

e) Set the “Initialize and script ActiveX controls not marked as safe
for scripting” to Enable.

f) Click the OK button to save the settings and to close the window.
You will go back to the Internet Options window.

g) Click the OK button to save the settings and to close the window.
5. Enable the “Include local directory path when uploading files to a

server” setting:
a) From the Tools menu, select the Internet Options option.

The Internet Options window is displayed (see FIGURE 3-9). 
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b) Go to the Security tab. 

FIGURE  3-9 Internet Options window - Security tab

c) Click the Trusted Sites icon.
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d) Click the Custom level... button.
The Security Settings - Trusted Sites Zone window is displayed
(see FIGURE 3-10). 

FIGURE  3-10 Security Settings - Trusted Sites Zone window

e) Set the “Include local directory path when uploading files to a
server” to Enable.

f) Click the OK button to save the settings and to close the window.
You will go back to the Internet Options window.

g) Click the OK button to save the settings and to close the window.
6. Configure the self-signed SSL certificate.
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a) Enter the IP address of the CIU 888 (i.e. https://192.168.1.1) in
the address bar of the browser. Press the Enter key.
The following warning message is displayed (see FIGURE 3-11). 

FIGURE  3-11 Website’s security certificate problem

b) Click the Continue to this website (not recommended) option.
You will go back to Microsoft Internet Explorer.

c) At the right of the address bar, click Certificate Error.
The Untrusted Certificate pop-up window is displayed (see
FIGURE 3-12). 

FIGURE  3-12 Untrusted Certificate pop-up window



Getting Started

Part No.: 4417584_Rev12 Configuration Manual
CIU 888 3 - 11

d) Click View certificates.
The Certificate window is displayed. Verify the certificate details.
(see FIGURE 3-13). 

FIGURE  3-13 Certificate window
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e) Click the Install Certificate... button.
The Certificate Import Wizard - Welcome window is displayed
(see FIGURE 3-14). 

FIGURE  3-14 Certificate Import Wizard - Welcome window

f) Click the Next button.
The Certificate Import Wizard - Certificate Store window is
displayed (see FIGURE 3-15). 

FIGURE  3-15 Certificate Import Wizard - Certificate Store window
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g) Select the Place all certificates in the following store radio
button. Click the Browse... button.
The Select Certificate Store window is displayed (see FIGURE 3-
16). 

FIGURE  3-16 Select Certificate Store window

h) Select Trusted Root Certification Authorities. Next, click the
OK button to save the settings and close the window.

i) Click Next.
The Certificate Import Wizard - Completing window is displayed
(see FIGURE 3-17). 

FIGURE  3-17 Certificate Import Wizard - Completing window

j) Click Finish.
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REMARK: If a Security Warning message is displayed (see FIGURE 3-18), click Yes and
then click OK. 

FIGURE  3-18 Security Warning message

k) From the Tools menu, select the Internet Options option.
The Internet Options window is displayed.
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l) Go to the Content tab. 

FIGURE  3-19 Internet Options window - Content tab

m)Click Certificates. 
The Certificates window is displayed.(see FIGURE 3-20). 



Getting Started

Part No.: 4417584_Rev12 Configuration Manual
CIU 888 3 - 16

n) Go to the Trusted Root Certification Authorities tab. 

FIGURE  3-20 Certificates window - Trusted Root Certification Authorities tab

o) Check if the CIU 888 website is listed.
p) Click Close to close the window.

You will go back to the Internet Options window.
q) Click OK to close the window.
r) Close (all instances of) Microsoft Internet Explorer.
s) Restart Microsoft Internet Explorer.

3.1.2 Changing the settings of Google Chrome

To access the CIU 888 using Google Chrome version 43, the following
changes in the browser settings must be implemented:

1. Launch Google Chrome.
2. Configure the self-signed SSL certificate.
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a) Go to Settings > Show advanced settings > HTTPS/SSL and
click Manage certificates... .

FIGURE  3-21 Navigate to the Manage certificates button on Google Chrome

b) In the ensuing Certificates window, click Import to launch the
Certificate Import Wizard.

FIGURE  3-22 Certificates window: Import button
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c) Click Next on the Welcome screen.

FIGURE  3-23 Welcome screen

d) Click Browse and select the certificate file with a .p7b extension.
You must select PKCS #7 certificates option to view the certificate
file with the .p7b extension.

FIGURE  3-24 Browse to the certificate file

e) Click Next.
f) In the Certificate Store screen, select the Place all certificates in

the following store option and click Browse.



Getting Started

Part No.: 4417584_Rev12 Configuration Manual
CIU 888 3 - 19

g) Click the Trusted Root Certification Authorities folder and click
OK.

FIGURE  3-25 Select folder to save certificate file

h) Click Next. Details of the certificate file you are importing are
displayed. Verify the details and click Finish.

FIGURE  3-26 Verify certificate details
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i) If a warning message appears, click Yes and continue.

FIGURE  3-27 Warning message

j) After the certificate is installed, a confirmation message appears.
Click OK.

FIGURE  3-28 Confirmation message
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k) Click the Trusted Root Certification Authorities tab to verify
that the certificate CIU 888 is added.

FIGURE  3-29 Verify installed certificate

3.1.3 To Allow Pop-ups for file download
Perform the following steps to allow pop-ups for file download:
1. Open the URL “chrome://settings/content/popups”.
2. Click on Allow > ADD.
3. Under Add a Site, enter the Site as https://192.168.1.1:443 (see

FIGURE 3-31). 

FIGURE  3-30 Adding a Site window
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3.1.4 Launching the CIU 888 Web interface
Perform the following steps to launch the CIU 888 Web interface:
1. Launch a browser (refer to section 2.1 for supported browsers).
2. Enter the IP address of the CIU 888 in the address bar of the

browser. The IP address is: 192.168.1.1. Press the Enter key.
The CIU 888 Login window is displayed (see FIGURE 3-31). 

FIGURE  3-31 CIU 888 Login window

3. Enter the username and password to log in to the CIU 888. The
username is: ciuadmin. Click LOG IN.
After entering a valid username and password, the CIU 888 Web
interface is displayed (see FIGURE 3-32). 

FIGURE  3-32 CIU 888 Web interface
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3.2 Configuring a site using CIU 888 Service Tool

The first step in configuration of CIU 888 is the creation of a site using
CIU 888 Service Tool. After a new site is created, the program prompts
for a set of global settings. Global settings are the overall configuration
settings applicable at a site level, see section 3.2.3 for more details.
Global settings are required for initiating any site configuration.

After the site global settings are entered, CIU 888 Service Tool prompts
for CIU 888 name and then CIU 888 Service Tool creates a site
configuration.

A site gives an overview of the configuration at a specific customer’s
site. The site configuration can be saved offline and opened at a later
point in time. Selecting a site gives you access to its configuration.
When the site is not available in the list, a new site must be created.

3.2.1 Preparation

Before you start configuring CIU 888, certain preparations are
necessary. Make sure the following information is available:

 Site layout
 Field cabling information (which gauges are connected on the

same pair of field wires, etc.)
 Tag names of field devices (gauges, CIU and tanks).
 Tank information (strapping tables, or tank capacity tables, roof

details, etc.)
 Information on the types of stored product
 Host communication setup
 Modbus TCP/IP Communication set up
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3.2.2 Launching CIU 888 Service Tool
1. Click  (Start) > All Programs > Honeywell > Configuration >

CIU 888 Service Tool R210
CIU 888 Service Tool is launched. The CIU 888 Service Tool screen
is displayed (see FIGURE 3.1). 

FIGURE  3-33 CIU 888 Service Tool

3.2.3 Creating a new site
1. From the Honeywell CIU 888 Service Tool window, Choose File >

New.

The Create new site window appears.
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2. Type the Site name and click OK.

The Global Settings - CIU 888 Service Tool window appears.

The Level can be configurable either -4 or -3 when the unit is m.

The Pressure can be configurable either -1 or -3 when the unit is kPa.

You can view or set the measuring unit of the various parameters in the
Global Settings dialog box.

Settings Units
Level dimension Select m, mm, ft, in, in/16, fis.

Temperature dimension Select ˚C or ˚F

Density dimension Select kg/m3, ˚API, lbs/ft3, RD60 or lbs/US gal.

Pressure dimension Select kgf/cm2, Pa, kPa or psi (lbf/in2).

Flow dimension Select m3/min, m3/hr, l/min, l/hr bbls/min, bbls/hr, US 
gal/min, Us gal/hr or UK gal/hr.

Volume dimension Select l, m3, US gal or bbls.

Mass dimension Select kg, ton, US ton, lbs or long ton.

Area dimension Select m2, mm2, ft2, in2,yd2

Std. ambient air pressure Enter ambient air pressure in kPa (default = 101.325 
kPa).

Air density Enter air density in kg/m3 (default = 1.226 kg/m3).

Level resolution This entity contains the desired resolution for rounding 
in communication of level values.
For meter (m) unit of measure, the resolution can be 
configured as -4 or -3 and the default selection is -4
For millimeter (mm) unit of measure, the resolution can 
be configured as -1 or 0 and the default selection is -1.

Temperature resolution This entity contains the desired resolution for rounding 
in communication of temperature values.
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3. Click OK, after the global settings are updated/modified.

A warning message appears.

4. Click Yes to continue.

The CIU 888 name window appears.

5. In the CIU 888 name box, type the name of the CIU 888 and click
OK.

Density resolution This entity contains the desired resolution for rounding 
in communication of density values.

Pressure resolution This entity contains the desired resolution for rounding 
in communication of pressure values.
For kPa unit of measure, the resolution can be config-
ured as -1 or -3 and default selection is -1.

Flow resolution This entity contains the desired resolution for rounding 
in communication of flow values.

Volume resolution This entity contains the desired resolution for rounding 
in communication of volume values.

Mass resolution This entity contains the desired resolution for rounding 
in communication of mass values.

Area resolution This entity contains the desired resolution for rounding 
in communication of area values.

Rounding scheme Defines the CIU  rounding scheme.
0 – CIU880 compatible Round (default)
1 – Bankers rounding
2 – Symmetric rounding
3 – Asymmetric rounding

Settings Units
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The CIU 888 Service Tool window appears.

3.2.4 Ensite pro database import option

For CIU 880 migrations with no new CIU 888 features, Migration tool
was used to upload the configuration to the CIU 888. For CIU 880
migrations with new CIIU 888 features like TRL/2 field scan, Modbus
TCP/IP host connectivity etc.., a new configuration was built from
scratch in the Service tool, and it was uploaded to the CIU 888.

Service tool provides a new option to Import the Ensite Pro database.
When the user imports an Ensite Pro database into Service tool,
Service tool automatically creates the site database using Ensite Pro
database contents. This option can be used for CIU 880 migrations with
or without new CIU 888 features.

1. From the Honeywell CIU 888 Service Tool window, Choose File
below window appears.
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2. click on Import Ensite DB and select the file from the folder.

3.2.5 CIU 888 Node Properties/Settings

3.2.5.1 Modify CIU 888 Properties

1. Click CIU 888 node, by default, the CIU 888 tab appears displaying
the properties.

You can view or edit these properties:

Properties Description
Priority agent Select Enable or Disable.

Refer to Appendix B.9 for more details.

CIU 888 Tag Name Displays CIU 888 name configured during 
site creation

Redundant state Select Primary or Non Redundant
This is the configured redundancy role of CIU 
888.
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3.2.5.2 Modify Ambient Temperature Properties

1. Click the Ambient Temperature tab, the properties detail appears.

You can view or edit these properties:

System decimal separator Select (point) or ,(comma)
This indicates the decimal separator in which 
data would be presented to the user in CIU 
888 Service tool and CIU 888.

System thousand separator Select (point), space or ,(comma)
This indicates the thousand separator in 
which data would be presented to the user in 
CIU 888 Service tool and CIU 888. 

Code CRC fault behavior This option sets the CIU behavior in the case 
of code CRC check failure.
• Stop functioning - CIU core functionality 

stops.
• CIU operations continue with data set to 

recalibrated and CIU CRC (Entity96) 
marked as corrupted so that Signature 
Alarm will be raised in Entis Host System.

Sync Link Timeout This indicates the time interval after which 
passive CIU would set all the field and calcu-
lated values to timeout status when sync link 
is broken.

Properties Description
Ambient temp. gauge address Enter ambient temperature transmission 

address.

Ambient temp. gauge TOI Select A, B, C, E or M*.

Ambient temp. gauge TOR Select C or ZAG*.

Ambient temp. scan enabled Check to enable ambient temperature scan.

* Refer to TABLE 3-1 for additional information.

Properties Description
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3.2.5.3 Modify OPC UA Properties

1. Click the OPC UA tab, the properties detail appears.

You can view or edit these properties:

Note: *Configure the Ambient Temperature settings only if ambient temperature is 
measured with a GPU gauge. If ambient temperature is measured with a Modbus 
gauge then configure it in Modbus Data input (refer to section 3.2.10.2).
If ambient temperature is measured with a TRL/2 gauge then configure it in TRL/2 
Data input (refer to section 3.2.10.4)

Properties Description
Protocol type This setting depicts the different OPC Proto-

col type. The following type is supported.
0 – OPC UA TCP

Default value: 0
Note: OPC UA HTTPS is not supported

Server port number This setting depicts the server port number.
Range 0- 65535
Default value: 51000

Properties Description
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3.2.6 Configuring a Field port

3.2.6.1 Serial Field Ports

1. On the CIU 888 node, right-click and choose Add > Field port/Host
port.

2. The Add Site Element window appears.

3. In the Name box, type the name of the Field port and click OK.
A field port node is created and displayed under CIU 888.

4. By default, the Field port tab appears.

Security Policy - None Security Mode and Security Policies are used 
in combination to secure endpoints. The 
security policy describes various algorithms 
and different key length, which is used to 
establish secure channel between client and 
server application. Security mode of the 
application defines the security level for a 
message being exchanged during communi-
cation between client and server. 
Available Modes:
None: non secure communication
Sign: secure communication without encryp-
tion
Sign and Encrypt: secure communication 
with encryption

Available Policies:
Basic256Sha256
Aes128Sha256
Aes256Sha256

Security Policy - Basic256Sha256 - 
Sign

Security Policy - Basic256Sha256 - 
Sign
and Encrypt

Security Policy - Aes128_-
Sha256_RsaOaep - Sign

Security Policy - Aes128_-
Sha256_RsaOaep - Sign and 
Encrypt

Security Policy - Aes256_-
Sha256_RsaPss - Sign 

Security Policy - Aes256_-
Sha256_RsaPss - Sign and Encrypt

Properties Description
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You can view or edit these properties:

NOTE 1: BPM field card is used to interface with the Honeywell Enraf BPM field bus
devices and RS-232C/RS485 field card is used to interface with the downlink
CIU 880 / CIU 888 / CIU 858 and third party Modbus field devices. The TRL/2
field card is used to interface with the Honeywell TRL/2 gauges and Rex
gauges.

NOTE 2: If Protocol type is Modbus RTU / CIU-GPU, configure Field port tab and RS
Field Port tab. If Protocol type is BPM-GPU, configure Field port tab and BPM
Field Port. If Protocol type is Modbus TRL/2, configure Field port tab and TRL/
2 Field Port tab. 

NOTE 3: When a field communication fails it is possible to maintain last valid scan data
in the CIU 888 database during a configurable amount of time. The
communication fail delay mechanism is reset on the reception of data. 
For Example:
- modem delays bad cabling.
- no answer because of re-initializing gauge.

NOTE 4: When a data fails it is possible to maintain the last valid scan data in the CIU
888 database during a configurable amount of time. The data fail mechanism is
reset on the reception of valid data. 
For Example:
- re-initialization of a gauge. 
- 802/811 digitizer failure.

NOTE 5: The setting in ‘Poll strategy’ determines the sequence in which the Field ports
are scanned: 
PPPPPP = all ports scan parallel (= default).
P11111 = port 1 scans parallel, others scan sequentially.
112233 = ports 1 & 2, ports 3 & 4 and ports 5 & 6 scan in a separate sequence.

Properties Description
Communication fail delay Enter a time between 0 and 255 seconds (default = 60). 

See Note 3.

Data fail delay Enter a time between 0 and 255 seconds (default = 60). 
See Note 4.

Poll strategy Select P, 1, 2, or 3.
See Note 5.

Protocol Type Select None, Modbus RTU (= RS-Communication), 
CIU-GPU (= RS-Communication), or BPM-GPU 
(= Honeywell Bi-Phase Mark) or Modbus TRL/2. See 
Note 1 and Note 2.

Field port option slot Select Option Slot 1, Option Slot 2, Option Slot 3, 
Option Slot 4, Option Slot 5, or Option Slot 6.
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5. Click the BPM Field Port tab, the Properties detail appears.

You can view or edit these properties:

6. Click the RS Field Port tab, the Properties detail appears. 

You can view or edit these properties:

Properties Description
Sensitivity Enter sensitivity in the range of 1 through 7 (default = 

7).

Baud rate Select 1200, 2400, or 4800.

Turn around delay When CIU 888 receives a response from a field instru-
ment (in a field port) it waits for this time period before 
sending a new request on the same field port.
Enter time in ms (default = 20 ms).

Time out Enter timeout in ms (default = 250 ms).

Retries Enter number of retries in the range of 1 through 10 
(default = 3).

Properties Description
Baud rate Select 1200, 2400, 4800, 9600, 19200, or 38400

Mode Select RS 232 or RS 485 (default = RS-232C).

Turn around delay Enter reply waiting time in ms (default = 20 ms).
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7. Click the TRL2 Field Port tab, the Properties detail appears. 

You can view or edit these properties:

3.2.6.2 Ethernet Field Port

On CIU 888 node click FTEA port.

By default FTE tab appears displaying various properties

Time-out Enter timeout in ms (default = 250 ms).

Note: For Modbus field ports, the default timeout of 250 
ms might not be sufficient in case of lower baud rates 
(1200, 2400 etc.,) and needs to be increased.
Calculate the field port timeout as Field port timeout = 
(1000 / baud rate) * No of bits in a byte * Maximum 
number of bytes retrieved from Modbus device in a 
single request ms and configure it accordingly.

Stop bits Select 1 or 2 (default = 1).

Parity Select Odd, Even, or None (default = Odd).

Duplex mode Select Full or Half (default = Full).

Retries Enter number of retries (default = 3)

Properties Description
Baud rate Baud rate is fixed and not editable (default = 4800 ms).

Turn around delay Enter reply waiting time in ms (default = 20 ms).

Time-out Enter timeout in ms (default = 400ms).

Stop bits Stop bit is fixed and not editable (default = 1 at 
Parity= None).

Parity Select Odd, Even, or None (default = None).

Retries Enter number of retries (default = 3)

Properties Description
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You can view or edit these properties.

Parameters Configuration options
Device name This indicates the device name of the Ethernet port. 

IP Address IP address of the corresponding Ethernet port in the 
CIU.

Format: a.b.c.d
Example: 10.70.100.101 

Subnet Mask Subnet mask of the corresponding Ethernet port in the 
CIU. In case of redundant CIUs, this also indicates the 
Subnet mask of the corresponding Ethernet port in the 
partner CIU.

Format: e.f.g.h
Example: 255.255.255.0

Default Gateway Default Gateway of the corresponding Ethernet port in 
the CIU. In case of redundant CIUs, this also indicates 
the default gateway of the corresponding Ethernet port 
in the partner CIU.

Format: i.j.k.l
Example: 10.79.100.1

Note: If no gateway is required, then this setting can be 
left blank.
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NOTE 6: When a field communication fails it is possible to maintain last valid scan data
in the CIU 888 database during a configurable amount of time. The
communication fail delay mechanism is reset on the reception of data. For
Example:
- modem delays bad cabling.
- no answer because of re-initializing gauge.

NOTE 7: When a data fails it is possible to maintain the last valid scan data in the CIU
888 database during a configurable amount of time. The data fail mechanism is
reset on the reception of valid data. 
For Example:

Field Scan Enable This indicates enable/disable of Field scan on the eth-
ernet port. That is, based on the need the user shall 
enable / disable filed scan on a particular ethernet port.

Note: Only one ethernet port (FTEA , FTEB or Office 
LAN), filed scan can be enabled out of 3 ethernet ports.

Note: Either modbus server or field scan functionality 
can be enabled for a ethernet port.

FieldScan IP IP address of wireless device manager (WDM) 

Note: CIU 888 is connected to WDM via ethernet and 
wireless gauges communicate to WDM via ISA 100.

FieldScan Port Port number of wireless device manager (WDM) .

Note: The default port number is 55598.

Turn around delay When CIU 888 receives a response from a field instru-
ment (in a field port) it waits for this time period before 
sending a new request on the same field port.
Enter time in ms (default = 20 ms).

Time out Enter timeout in ms (default = 250 ms).

Retries Enter number of retries in the range of 1 through 10 
(default = 3).

Communication fail delay Enter a time between 0 and 255 seconds (default = 60). 
See Note 3.

Data fail delay Enter a time between 0 and 255 seconds (default = 60). 
See Note 4.

OPC UA server enable This setting would enable / disable the OP CUA Server 
on the CIU 888's ethernet port (FTEA / FTEB / LAN).
0 - OPC UA server is disabled
1 - OPC UA server is enabled

Server URL This setting depicts the server URL. The OPC UA cli-
ents to CIU 888 using this URL. The URL shall be in the 
below format.
opc.tcp://192.168.20.10:51000

Default value: Empty string

Parameters Configuration options
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- re-initialization of a gauge. 
- 802/811 digitizer failure.

NOTE 8: “Time out” parameter needs to be configured based on the wireless network
topology. 
It is recommended to configure 1500ms as “Time out” value when there are 6
hops wireless network.

NOTE: Procedure to configure FTEB and Office LAN will be same as that of FTEA
mentioned above.

3.2.7 Configuring a Tank

3.2.7.1 Configuring tank under serial field port

1. After Field port is configured, you need to link the Tanks to the Field
port.

2. On the Field Port 1 node, right-click and choose Add > Tank.
3. The Add Site Element window appears.

4. In the Name box, type the name of the Tank and click OK.
5. The Tank1 node is created and displayed under Field port 1.

6. By default, the Tank tab appears.

You can view or edit these properties:

Properties Description
Tank name Name of the Tank

Tank available Check, if allowed

Tank Scan Select Enable or Disable

Level type Select Innage or Ullage/Outage
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7. Click the Product tab, the Properties detail appears.

You can view or edit these properties:

‘

8. Click the Shell tab, the Properties detail appears.

Shape Select the tank shape for this tank

0 = No shape defined, 
1 = Cylindrical fixed roof, 
2 = Cylindrical with floating roof, 
3 = Cylindrical with internal floater, 
4 = Spherical tank, 
5 = Bullet, 
6 = Underground bullet, 
7 = Irregular cavern
8 = External floating roof with geodesic roof
9 = Horizontal cylindrical tank

10...255: Reserved for future expansion by Honeywell

Properties Description
HIMS/HTMS not allowed Check to disable Hybrid Inventory Management Sys-

tem.

HTG Check to enable Hydrostatic Tank Gauging.

Properties Description
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You can view or edit these properties:

9. Click the Floating Roof tab, the Properties detail appears. 

You can view or edit these properties:

Properties Description
Tank capacity table The file name and path of the TCT file selected by the 

user.

This entity is stored in the site database but will not be 
downloaded to any CIU.

Level type Tank type
This is a bit coded entity which contains the following 
information:
Bit 0 = 1 Level measurement is Ullage if bit is set : the 
Level value decreases when product is pumped into the 
tank, level 0 is at or near the top of the tank [Innage (0): 
lev

Properties Description
Zone enabled:

Zone 1 Enabled Check to enable the option.

Zone 2 Enabled Check to enable the option.

No GOV calculation:

Zone 1 No GOV calcula-
tion

Check to disable volume calculation when level is in 
zone 1.

Zone 2 No GOV calcula-
tion

Check to disable volume calculation when level is in 
zone 2.

No Water Volume calculation:

Zone 1 No Water 
Volume calculation

Check to disable the option.

Zone 2 No Water 
Volume calculation

Check to disable the option.

Roof Weight:
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NOTE: High/low zones: The program issues a warning if the low value is higher than
the high value.

10.Click the Water Details tab, the Properties detail appears. 

You can view or edit these properties:

Zone 1 Roof Weight Enter the weight of the tank roof.

Zone 2 Roof Weight Enter the weight of the tank roof.

High:

Zone 1 High Enter no-go-zone 1 high level.

Zone 2 High Enter no-go-zone 2 high level.

Low:

Zone 1 Low Enter no-go-zone 1 low level.

Zone 2 Low Enter no-go-zone 2 low level.

Properties Description
Free water in tank For those tanks which might contain water we want to 

perform ‘free water’ calculations.

Note: we call this ‘free water’ as water might also be 
dissolved or suspended in the product.

Input:
Selection: (Free) Water in Tank: Yes | No

Properties Description
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Free water calculated 
from

This indicates whether Water volume is calculated 
based on Tank TCT or separate Water TCT.

Selection: None | Main TCT | Separate Water TCT

Note:
Often the water content is much smaller than the actual 
heel volume of the tank. In these cases the use of the 
regular TCT for assessing the free water volume is use-
less.
Often also the (free) water level is measured in a sepa-
rate ‘water sump’ as innage. Consequently a zero read-
ing is not equivalent with the zero volume of the TCT 
(which is by definition equal to the heel volume).
Hence the need to be able to define a separate (Free) 
water TCT, which is only used for calculating the water 
volume which can then be subtracted from the TOV.

Water tank capacity table The file name and path of the water TCT file selected by 
the user.

Water volume at no water 
found

Water Volume under Range.
Whenever the Free Water Level drops below the mini-
mum Value, the Water Volume will no longer be calcu-
lated. The “WaterVolumeUnderRange” will be used 
instead. 

This entity is configured by the service tool.

Reduced accuracy of 
water level only used for 
water volume

Status “reduced accuracy” of Water Volume is not 
inherited by derived data.

Manual status of TC not 
copied to derived data

Status “manual” of (manually entered) ProductTC 
(Alpha), is not inherited by derived data.

Manual status of VCF not 
copied to derived data

Status “manual” of (manually entered) [CTL], is not 
inherited by derived data.

Uncalibrated status of 
water level only copied to 
water volume

Status “not calibrated” of Water Volume is not inherited 
by derived data if water is measured automatically

Stored status of water 
volume, Dref and prod. 
Temp not derived

Status “stored” of the following entities is not inherited 
by derived data:
• WaterVol (WaterLevel was measured via a Water 

Dip: 811/854/954 gauge)
• ProductDRef ([DObs] was measured via a Density 

Dip: 854/954 gauge)

Properties Description
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11.Click the Shell Volumetric Corrections tab, the Properties detail
appears.

You can view or edit these properties:

Manual status of water 
vol.,Dref, temp and pres-
sure not derived, when 
value is not automati-
cally measured.

Status “manual” of the following entities is not inherited 
by derived data, if the appropriate instrument is not 
installed on the tank (entity can not be measured):
• ProdTemp 
• AmbientTemp
• WaterLevel (status is only copied to WaterVol)
• [DObs] status is only copied to ProdDRef)
• VapTemp
• VapPress

Properties Description
Tank shell ref. tempera-
ture

Tank Shell Reference Temperature.
Tanks undergo expansion and contraction, due to varia-
tions in AmbientTemp and ProdTemp.
This results in incorrect level readings, which makes it 
necessary to correct the calculated volumes.

Tank Shell Correction 
(CTSh)

Enable the calculation of the Correction of the Tank 
Shell.

Properties Description
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12.Click the Minimum & Maximum quantities tab, the Properties
detail appears. 

You can view or edit these properties:

Tank shell exp. coeff Tank shell expansion coefficient (TankTC).
Tanks undergo expansion and contraction, due to varia-
tions in AmbientTemp and ProdTemp.

This results in incorrect level readings, which makes it 
necessary to correct the calculated volumes.

TankTC is the expansion coefficient of the Tank Shell 
material:

Tank Shell material TankTC per OC TankTC per OF
Mild CarBon steel
 0.0000112 0.00000620
304 Stainless steel
 0.0000173 0.00000960
316 stainless steel
 0.0000159 0.00000883
17-4PH stainless steel
 0.0000108 0.00000600

TankTC must be entered in format 10e-5 (shift decimal 
point 5 positions to the right), e.g. 0.0000112 must be 
entered as 1.12.

Insulation factor Tank Shell Insulation Factor.
The Insulation Factor (0 < Insulation <= 1.0) indicates 
how well the tank shell is insulated from the environ-
mental temperature (AmbientTemp) outside the tank.
For a fully insulated tank (TankShellTemp = ProdTemp), 
Insulation = 1.0.

Default value : 0.875

Properties Description
High level Enter level that corresponds with high TOV (for graphi-

cal purposes in Entis Pro).

Low level Enter level that corresponds with low TOV (for graphical
purposes in Entis Pro).

Properties Description
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13.Click the GRH corrections tab, the Properties detail appears. 

You can view or edit these properties:

Note: The application checks the high level to be higher than the low level for 
innage. If the tank is set up for ullage the high level value must be lower than the low 
level value.

High TOV Enter volume that corresponds with high level (for 
graphical purposes in Entis Pro).

Low TOV Enter volume that corresponds with low level (for graph-
ical purposes in Entis Pro)

Note: The application checks the high TOV to be higher than the low TOV for 
innage. If the tank is set up for ullage the high TOV value must be lower than the low 
TOV.

Total Tank Space This is the total volume of the tank itself, including all 
space which will never contain liquid product and is 
needed for vapor calculations.

Shell capacity The absolute maximum of liquid which can be con-
tained by the tank shell. Exceeding this level results in a 
direct overfill.

Properties Description
Gauge Reference Height Gauge Reference Height

Height of gauge above tank zero. Used to calculate 
Ullage and corrected Innage.

Temperature GRH Cor-
rection

This correction corrects for the temperature effects of 
the tank shell and/or stilling well.

Selection: Enable / Disable

TEC Grh Thermal expansion coefficient of the Stilling well or Tank 
Shell.

Note:
Thermal expansion coefficient values in ppm (10E-6/C 
(or) 10E-6/F) needs to be converted to 10E-5/C (or) 
10E-5/F. For example, the value of 16 10E-6/C (ppm) 
needs to be converted to 1.6 and then set in Service 
tool.

Properties Description
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14.Click the Flow tab, the Properties detail appears. 

You can view or edit these properties:

Insulation factor dry The Insulation Factor Dry (0 < Insulation <= 1.0) 
indicates how well the tank shell is insulated from the 
environmental temperature (AmbientTemp) outside the 
tank for the dry portion (Vapour space).

Insulation factor wet The Insulation Factor Wet (0 < Insulation <= 1.0) 
indicates how well the tank shell is insulated from the 
environmental temperature (AmbientTemp) outside the 
tank for the wet portion (Liquid space).

Pressure GRH correction This correction is only applicable on fixed roof tanks 
without stilling well and corrects for the changes in GRH 
due to the lifting of the roof caused by the vapor pres-
sure under the roof of the tank.

Selection: Enable / Disable

GRHP Factor GRH Pressure Factor:
This indicates level change per unit pressure.

Properties Description
Moving detection trip 
level

Movement Detection Trip Value.
Whenever MoveDir is calculated, the actual measured 
level is compared with [ProductLevel] at the time of the 
previous check, see MoveInterval.

If the difference exceeds the value of MoveTrip, thus 
reducing the effect of ext

Moving detection interval Interval Time for MoveDir Calculation.
MoveIterval (>= 0) is the interval time, in seconds, after 
which the movement direction of [ProductLevel] must 
be calculated again.

MoveInterval is checked each time that the tank is cal-
culated ([ProductLevel] is me

Properties Description
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15.Click the RIC tab, the Properties detail appears.

You can view or edit these properties:

Flow calculation interval Interval Time for Flow Rate Calculation.
FlowInterval (>= 0) is the interval time, in seconds, after 
which the the flow rate of TOV must be calculated 
again.

Flow Interval is checked each time that the tank is cal-
culated ([ProductLevel] is measured).

Not

Flow calculation damping Flow Rate Multiplication Factor.
Damping Factor for Flow Rate Calculation.
To obtain a steady flow rate, a damping factor (0.0 < 
FlowMul <= 1.0) is used.

If FlowMul = 1.0, the flow rate is not damped at all, but it 
can be very unstable then.

If the flow

Flow calculation indepen-
dent of moving status

Bit 3 from entity 8140

Flow trip Flow Rate Calculation Trip Value.
Whenever FlowTOV is calculated, the actual calculated 
TOV is compared with TOV at the time of the previous 
check, see FlowInterval.

If the difference exceeds the value of FlowTrip, thus 
reducing the effect of external in

Note: FlowTOV is only calculated in case of 880 calculation flow.

Properties Description
Roof Immersion Com-
pensation

This compensates the volume for the effects of dynamic 
loads like snow, rain water on top of the floating roof.
Selection: Enable / Disable

Ref. FR level sensors 1 Reference floating roof level sensors 1

Ref. FR level sensors 2 Reference floating roof level sensors 2

Ref. FR level sensors 3 Reference floating roof level sensors 3

Properties Description
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16.On the Tank1 node, right-click and choose Add Tank Capacity
Table.

The following window appears.

RD1 Reference distance from top surface measuring pipe 1 
to liquid level

RD2 Reference distance from top surface measuring pipe 2 
to liquid level

RD3 Reference distance from top surface measuring pipe 3 
to liquid level

Hpavg Average height top measuring pipe to lowest edge pon-
toon bottom

Vconst Liquid volume under the pontoon membrane and bot-
tom, calculated during tank calibration.

Total cross section area 
of FR

Total cross section area of floating roof

Calibration Liquid Density Calibration Liquid Density
This is the density (observed) of the product under a 
roof, used during tank calibration, in kg/m3

Properties Description
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You can add a new Tank Capacity Table or view an existing one.

17.On the Tank1 node, right-click and choose Add Water Tank 
Capacity Table

The following window appears.

You can add a new Water Tank Capacity Table or view an existing one.

Properties Description
Tank Capacity Table Refer to Appendix D for the format of Tank Capacity 

Table.

Browse Click ‘Browse’ to select a tank capacity table. Selected 
file is copied to the data environment of the selected 
site (C:\Users\Public\Documents\Honeywell\CIU 888 
Service Tool\SiteDatabase\<sitename>\STR. 
The copied file gets the name [Tank name].txt.

View Click ‘View’ to view the tank capacity table.

Note: A selected tank capacity table file is only accepted if the used engineering
units match the global selected engineering units of the site configuration.

Properties Description
Water Tank Capacity 
Table

Refer to Appendix D for the format of Water Tank 
Capacity Table.
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3.2.7.2 Configuring tank under Ethernet field port:

On the FTEA port node, click and choose Add > Tank

The “Add site element” window appears

In the name box, type the name and click OK.

The tank1 node is created and displayed under ethernet filed port.

NOTE: For configuring tank refer Section 3.2.7.1

Browse Click ‘Browse’ to select a water tank capacity table. 
Selected file is copied to the data environment of the 
selected site (C:\Users\Public\Documents\Honey-
well\CIU 888 Service Tool\SiteData-
base\<sitename>\STR. 
The copied file gets the name [Water Tank name].txt.

View Click ‘View’ to view the water tank capacity table.

Note: A selected water tank capacity table file is only accepted if the used 
engineering units match the global selected engineering units of the site 
configuration.

Note: In case of a separate water sump in the tank, a water TCT can be used and 
water TCT should be based on geometry and dimensions of the sump.

Properties Description
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3.2.7.3 Associating a Product to Tank

1. On the Tank node, right-click and choose Associate product> Select
Product from the drop down and click OK.

2. Desired Product is successfully associated to the Tank. Click Ok.

3.2.8 Product configuration

3.2.8.1 Configuring product under products

1. On the Products node, right click and choose Add > Product
2. The Add Product window appears.

3. In the Name box, type the name of the Product and click OK.
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4. The Product node is created and displayed under Products.

5. By default, the Product Details tab appears.

You can view or edit these properties:

6. Click the Liquid Calculation Details tab, the Properties detail 
appears.

Properties Description
Product name Name of the Product.

Name can be up to 30 characters.

Product Id A unique Identifier assigned to a product. This 
is internally generated by the service tool.

Material Safety Data Sheet Information on Product Safety sheet can be 
stored under this option for reference.

Legal Metrology This is a selection which can be set after con-
figuration is complete and verified, whether 
the product is configured correctly and can be 
‘sealed’.
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You can view or edit these properties:

Properties Description
Calculation Type This setting indicates the tank inventory 

calculation type.

Possible values:
CIU 880 compatible – User shall select 
this calculation type for tank inventory cal-
culations that match with that of CIU 880 
or CIU 888 (lesser than R161.2 version). 
For example, for CIU 880 migrations, this 
calculation type shall be chosen. 
CIU 888 calculations – User shall select 
this calculation type for tank inventory cal-
culations adhering to the latest API stan-
dards and for new product calculations. 
Currently vapor inventory calculations are 
not supported in this type and hence can 
be chosen for products that involve only 
liquid inventory calculations.

Default value: CIU 880 compatible

User Configurable Table This setting provides the name of the user 
configured table associated to the GSV 
Calc type.
Three tables are possible:
User configured density table
User configured CTL table
User configured concentration table

Aromatic HC (ASTM D1555(M)) This setting provides a list of aromatic 
hydrocarbons that can be selected when 
GSV Calculation type is  ASTM D1555-
2016 API @ 60 F / ASTM D1555M-2016 
kg/m3 @ 15 C

Selection: which Aromatic HC (Benzene | 
Cumene | Cyclohexane | Ethylbenzene | 
Styrene | Toluene | m-Xylene | o-Xylene | 
p-Xylene | 300 to 350 °F (148.9 to 176.7 
°C) | 350 to 400 °F (176.7 to 204.4 °C) 
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GSV calculation type This setting provides a list of GSV calcula-
tion methods (Liquid calculation methods) 
supported.
Selection: 

Default: No Liquid calculation method

Note: The following methods are only 
available when Calculation type is 
selected as CIU 888 calculations.
a) ASTM D4311-15 API @ 60 F
b) ASTM D4311M-15 kg/m3 @ 15 C
c) ASTM D1555-2016 API @ 60 F
d) ASTM D1555M-2016 kg/m3 @ 15 C
e) EN15940- 2019
f) SGS-2021
g) NBR15639-2016
h) User Configurable Density table
i) User  Configurable CTL table
j) User Configu rable Concentration table

Alpha Type This setting indicates how Alpha (Product 
TC) should be interpreted.
Selection: Alpha60
Default: Alpha60

Product code/commodity This setting indicates which product type 
to be applied for the selected GSV Calcu-
lation type.

Reference temperature Product Reference Temperature.
The volume of the product in a tank varies 
with changes of ProdTemp.

This causes changes in the product level 
which result in incorrect volume calcula-
tions.

ProdTRef is used to get calculation results 
(volumes, mass) which are independent of 
the temperature of the product in the tank 
at the time of the measurement.

Alpha Product Temperature Coefficient.
Manual:
Only with Product Code C the ProdTC is 
entered manually.
It must be entered in 10e-7 format (shift 
the decimal separator 7 positions to the 
right), e.g. 0.000612 is entered as 6120

With Product Codes A, B and D, ProdTC 
is calculated and not used with other cal-
culations.
With Product Code E it is not used at all.

Properties Description
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CTL (VCF) CTL (Correction for the effect of Tempera-
ture for Liquid)
Historical known as VCF (Volume 
Correction).
With special products CTL can be entered 
manually

Normally, CTL will be calculated according 
to ASTM/API procedures

TCF Product Temperature Correction Factor 
(TCF).
Normally, VCF is calculated, using the 
ASTM/API tables.

The TCF method provides an alternative 
for this calculation.
The TCF is used to calculate the CTL with 
Chemical Products.

DCF Product Density Correction Factor (DCF).

The DCF is used to calculate [DObs] with 
Chemical Products.

Density Input This setting indicates the type of the den-
sity input.
Selection: (Reference density | Sample 
density and temperature | N.A.)

Based on the selected GSV Calculation 
type, Service tool provides options for this 
setting.

Sample Density Sample density refers to density data 
obtained from a manual sample. Sample 
density always needs to be provided in 
combination with the sample temperature.

Sample Temperature Sample temperature is not the tempera-
ture of the sample when it was taken, but 
the temperature when the density was 
determined (for example using a hydrom-
eter).

Hydrometer correction The hydrometer correction is needed 
when the density of the sample is deter-
mined using a ‘glass’ hydrometer. This 
correction corrects the thermal expansion 
of the glass of the hydrometer.
Selection: Enable | Disable

Properties Description
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Range checking disable This setting refers to whether range check 
is enabled / disabled in the tank inventory 
calculations for the selected GSV calcula-
tion type.
Selection:
Checkbox (Selected) – Extended Range 
(beyond defined by the standard) is sup-
ported.
Checkbox (Not Selected) – Extended 
Range (beyond defined by the standard) 
is not supported.

Mass calculation This setting indicates whether Mass calcu-
lation is performed for In vacuum or In air.

Selection:
In vacuum – Mass in vacuum is calcu-
lated.
In air – Mass in air is calculated.

Note:
For 888 calculations, Mass In vacuum is 
only supported as weight can be calcu-
lated by configuring WCF method.

Volume mass correction VolumeCorrections:
This setting indicates which correction 
must be applied to the calculated volume.

Selection:
None (no vapour mass)
S&W corr. (Liq Mass from NSV; no Vap 
mass)
Vapour calc. Liq/Vol ratio ISO/TC28/SC 
3N
Vapour calc. molar method ISO/TC28/SC 
3N
Vapour calc. method API research proj. 44
Vapour calc. molar method ISO 6578

Note:
For CIU 888 calculations type, vapour cal-
culations are not supported and hence 
only S&W corr is applicable.

Air density Air Density is always in kg/m3, regardless 
of the units in which the system is config-
ured.

Default: 1.226

Properties Description
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Refer to the following table for information on different WCF methods

Density of calibration weights Brass density is used in some of the stan-
dardized mass/weight conversion meth-
ods. It is the density of used calibration 
weights.

Default: 8000 kg/m3

Note:
• - Unit of measure is always kg/m3

CTL format This setting indicates the format of CTL 
(VCF) that gets presented from CIU.

Selection:
Standard calculations – CTL value would 
be preseted with 5 decimal digits when 
value is less than 1 and 4 decimal digits 
when value is greater than 1.
Always 4 decimals – CTL value would be 
presented with 4 decimal digits.
Always 5 decimals - CTL value would be 
presented with 5 decimal digits.

Default: Standard calculations

WCF Method This setting indicates the method to calcu-
late Weight Correction Factor and thereby 
calculate Weight.

Selection: (NONE | OIML R125 | API 
MPMS CH11.5 | SIMPLIFIED | CUSTOM)

Default: NONE

WCF Method TankAirDensity 
(kg/m3)

VapDensity 
(kg/m3)

AirBrassDensity 
(Density of calibration 
weights)
(kg/m3)

Remarks

NO WCF 0 0 0

OIML R125 TankAirDensity TankAirDensity 8000 The value of Dair is 
configurable in the Global 
settings.

Properties Description
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Notes on GSV Calculation Type:

a) Reference density can be an input for the following tables
 ASTM D 1250-80 T5/6, ASTM D 1250-80 T23/24, ASTM D 1250-80

T53/54, ASTM D 1250-80 T59/60
 API MPMS Ch. 11.1 (2004) API @ 60 F (T5/6), API MPMS Ch. 11.1

(2004) RD60 @ 60 F (T23/24), API MPMS Ch. 11.1 (2004) kg/m3 @
15 C (T53/54), API MPMS Ch. 11.1 (2004) kg/m3 @ 30 C (T59/60)

 ASTM-IP-52 T23/24, ASTM-IP-52 T53/54
 API MPMS Ch. 11.2.4 (2007) (GPA TP-27-07) T23/24, API MPMS

Ch. 11.2.4 (2007) (GPA TP-27-07) T53/54, API MPMS Ch. 11.2.4
(2007) (GPA TP-27-07) T59/60

NOTE: Reference density overwrite - For the above mentioned GSV calculation types
(Bullet point 1 to Bullet point 4), the host system should overwrite Sample
density and Sample temperature with Sample density = Desired Reference
density and Sample temperature =  Product Reference temperature.

 ASTM D4311-83 T1, ASTM D4311-83 T2, ASTM D4311-96 T1,
ASTM D4311-04 T1, ASTM D4311-04 T2, ASTM D4311-15 API @
60 F, ASTM D1555M-15 kg/m3 @ 15 C

 LinearTCF, ManualCTL, User Configurable CTL table
 EN15940-2019, SGS-2021, NBR15639-2016
 Sample density and sample temperature can be input for the

following tables
b) ASTM D 1250-80 T5/6, ASTM D 1250-80 T23/24, ASTM D 1250-

80 T53/54, ASTM D 1250-80 T59/60
 API MPMS Ch. 11.1 (2004) API @ 60 F (T5/6), API MPMS Ch. 11.1

(2004) RD60 @ 60 F (T23/24), API MPMS Ch. 11.1 (2004) kg/m3 @
15 C (T53/54), API MPMS Ch. 11.1 (2004) kg/m3 @ 30 C (T59/60)

API MPMS Ch 
11.5

1.199228 1.199228 8000 Use of the ‘general’ air buoy-
ancy correction equation as 
detailed in OIML is equiva-
lent to the equation used in 
API MPMS Ch. 11..5.3. The 
derivation is even spelled out 
in Annex B.5 of the same 
document.

Simplified TankAirDensity 0 0

Custom Custom Custom Custom This method is ‘Advanced’ 
and allows users/operators 
to configure each of the 
three inputs to any value.

WCF Method TankAirDensity 
(kg/m3)

VapDensity 
(kg/m3)

AirBrassDensity 
(Density of calibration 
weights)
(kg/m3)

Remarks
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 ASTM-IP-52 T23/24, ASTM-IP-52 T53/54
 API MPMS Ch. 11.2.4 (2007) (GPA TP-27-07) T23/24, API MPMS

Ch. 11.2.4 (2007) (GPA TP-27-07) T53/54, API MPMS Ch. 11.2.4
(2007) (GPA TP-27-07) T59/60

 ASTM D1555-2016 API @ 60 F, ASTM D1555M-2016 kg/m3 @ 15 C 
 EN15940-2019, SGS-2021, NBR15639-2016

c) For NBR15639-2016, the order of precedence is Reference
density, mass concentration and Sample density & sample
temperature. Set the Density input to N.A, to set mass concen-
tration as the input.

d) For SGS-2021, the order of precedence is Reference density,
Sample density & sample temperature.

e) For EN15940-2019, the order of precedence is Reference density,
Sample density & sample temperature.

f) For User Configurable Density table, associate a user defined
density table by right clicking product site element and selecting
“Add density table” option. Refer to Appendix E for the format of
the user defined density table.

g) For User Configurable CTL table, associate a user defined density
table by right clicking product site element and selecting “Add CTL
table” option. Refer to Appendix F for the format of the user
defined CTL table.

h) For User Configurable Concentration table, associate a user
defined density table by right clicking product site element and
selecting “Add concentration table” option. Refer to Appendix G
for the format of the user defined concentration table.

7. Click the Product Operational Settings tab, the Properties detail
appears.
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You can view or edit these properties:

8. Click the Vapour Calculation Details tab, the Properties detail
appears.

You can view or edit these properties:

Properties Description
S&W The product in tank can contain 

Sediment and Water which is dissolved 
in it.
Range: 0 to 100 (%)

Concentration The concentration of the product.
Range: 0 to 100 (%)

Notes:
- For “User configurable concentration 
table”, this setting indicates volume 
concentration percentage
- For “NBR15639-2016”, this setting 
indicates mass concentration percent-
age

Properties Description
Vapour density Density of the vapour.

Note:
- Unit of measure is always kg/m3
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Liq/Vol ratio This setting refers to Liquid to Volume Ratio.
In some tanks (pressurized) the room above 
the product is filled with vapour which, in con-
densed form, would take a certain amount of 
product (volume). This volume can be calcu-
lated.

Typical values for LiqVolRatio with various 
products, measured at the standard ProdTRef 
of 15C or 60F, are:

Ethane 293.3 Cis-Butene-2 255.9 Butane 
229.5
Propene 288.3 Trans-Butene-2 248.9 ISO-
Pentane 193.7
Propane 266.7 ISO-Butene 245.0 Pentane 
194.8
Butene-1 245.2 ISO-Butane 221.9  

If the gas is a mixture of above products, 
LiqVolRatio can easily be calculated from the 
appropriate factors, according to the contribu-
tion of each gas component.

Molar mass Molar weight of the gas composition.
In some tanks (pressurized) the room above 
the product is filled with vapour which, in con-
densed form, would take a certain amount of 
product (volume).
This volume can be calculated.

Typical values for MolarWeight (expressed in 
kg/kmol)  with various products, measured at 
the standard ProdTRef of 15 C or 60 F, are:

Ethane 30.070
Propane 44.097
Butane 58.124
ISO-Butane 58.124
Pentane 72.151
ISO-Pentane 72.151

MolarWeight is used with the calculation of:
• LiqVap, using the molar method according to:
-ISO/TC28/SC3 N411 (molar method)
-ISO 6578
-API research Project 44

Properties Description
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3.2.9 Product configuration Export and Import

Service tool supports product configuration export and import. On
Export, product configuration is saved into a file (JSON). On Import of
the product configuration from a file (JSON), Service tool creates the
products in the CIU configuration database in accordance with the
content specified in the product configuration file.

For sites with multiple CIU 888s, the product settings across all the CIU
configuration databases should be same. When CIU configuration
database is loaded to ENTIS configuration tool, it compares the product
settings across CIU configuration databases and flag an error in case of
a mismatch. For sites with multiple CIUs, the recommendation is to
create all products in one CIU configuration database, export the
product configuration from it and import the same into other CIU
configuration databases.

3.2.9.1 Export of product configuration 

1. On the Products node, right-click and click Export Products from the
drop down.

Vapour mass calculation This setting is used to indicate which correction 
must be applied to the calculated volume.

Selection:
None (no vapour mass) -  No correction 
applied
S&W corr. (Liq Mass from NSV; no Vap Mass) 
– Sediment and Water correction applied
Vapour calc. Liq/Vol ratio ISO/TC28/SC 3N - 
LiqVap  calculations according Liq/Vol Ratio 
ISO DP 4267/1 1982 (ISO/TC28/SC 3 N 411)
Vapour calc. molar method ISO/TC28/SC 3 N -  
LiqVap  calculations according Molar method 
according to ISO DP 4267/1 1982 (ISO/TC28/
SC 3 N 411)
Vapour calc. method API research proj. 44 -  
LiqVap  calculations according Molar method 
according to API research project 44
Vapour calc. molar method ISO 6578 - LiqVap  
calculations according Molar method according 
to ISO 6578

Notes:
- when S&W correction (NSV calculation) is 
selected, Vapour calculations are disabled.

Properties Description
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2. Choose a file name and click Save.

3. Product configuration is successfully exported, and a confirmation
message pops up. Click OK.
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3.2.9.2 Import of product configuration 

1. On the Products node, right-click and click Import Products from the
drop down.

2. Browse to the desired product configuration file and click Import.

3. Message on reconfirmation of deletion of existing products pops up. For
proceeding, click Yes.
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4. Product configuration is successfully imported, and a confirmation
message pops up. Click OK.

3.2.10 Configuring a GPU Data Input or Modbus Data Input or TRL/2 Data Input

After Tanks are linked to the applicable Field ports, you should add
either GPU Data Input or Modbus Data Input or TRL/2 Data Input to the
respective Tanks.

3.2.10.1 GPU Data Input

3.2.10.1.1 Data Integration supported
1. Product Level etc

The CIU 888 collects measurement data like Product level, Product
temperature etc., from the BPM gauges and exposes the data in its
Modbus output (Modbus RTU and Modbus TCP/IP) based on the
configuration. Using this mechanism any Modbus host system can get
the data from CIU 888 and visualize it in its user interface. 

2. Temperature profiles

The CIU 888 also collects temperature profiles data from the BPM
gauges and exposes the data in its Modbus output (Modbus RTU and
Modbus TCP/IP) based on the configuration. The CIU 888 collects data
for a maximum of 16 temperature elements. Using this mechanism any
Modbus host system can get the temperature profiles data from CIU
888 and visualize the data in its user interface.

3. Density profiles

The CIU 888 collects density profiles data from the BPM gauges and
expose the data in its Modbus output (Modbus RTU and Modbus TCP/
IP) based on the Modbus coil command from the host system. The CIU
888 collects data for a maximum of 50 density points. Using this
mechanism, any Modbus host system can issue a density profile
command via Modbus coils and get the density profiles data from CIU
888 and visualize the data in its user interface. 



Getting Started

Part No.: 4417584_Rev12 Configuration Manual
CIU 888 3 - 65

The CIU 888 supports density profile upward, density profile
downwards, interface profile upward, interface profile downward,
combined profile upward and combined profile downward commands
via Modbus coils. 

The following steps detail out the configuration procedure.

1. On the Tank1 node, right-click and choose Add > GPU Data Input.

2. The Add Site Element window appears.

3. In the Name box, type the name of the GPU Data Input and click OK.
4. The G1 node is created and displayed under Tank1.

5. By default, the Gauge tab appears.

You can view or edit these properties:

Properties Description
Data Input Name You can see the name of the GPU Data Input

Gauge Detail Select ‘h’ for 854 gauges using the ZLQ record (up to 
software version SPUA1.0) or select ‘-‘ for 854 gauges 
(with software version SPUA2.0 onwards).

Gauge Type Select Unknown, 811, 854, 866, 872, 873, 877, 894, 
954, 970, 971, 973, or 990.
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Allow Interface 2 com-
mand

Check the option, if allowed (I2; 854, 894, 954 only).

Allow Block gauge Check the option, if allowed (BL; 811, 854, 894, 954 only).

Allow Tank profile Check the option, if allowed (TP; 854, 894, 954 only).

Allow Gauge alarm test Check the option, if allowed (AT; 873 only).

Allow Lock test Check the option, if allowed (LT; 811, 854, 894, 954 only).

Allow Reset gauge Check the option, if allowed (RS).

Allow Test gauge Check the option, if allowed (TG; 811, 854, 894, 954 only).

Allow Verify command Check the option, if allowed (CA; 854, 894, 954 only).

Allow Water dip Check the option, if allowed (I3; 811, 854, 894, 954 only).

Allow Interface profile Check the option, if allowed (IP; 854, 894, 954 only).

FlexConn address Set the option, if allowed (954, 990 Only).

Primary Gauge This indicates whether the gauge is primary or not. For 
primary gauge, all measurements can be enabled for 
scan and gauge commands can be enabled. For sec-
ond gauge (non-primary), only product level measure-
ment can be enabled for scan and gauge commands 
are not supported.

Wire Compensation This setting enables (or) disables servo wire correction. 
This is applicable only for Servo gauge. When enabled, 
product level is corrected for the temperature effects on 
the Servo wire.

Note:
- Servo wire correction is supported by 954 Servo 
gauge, if enabled in gauge do not enable this correction 
in CIU.

Servo Wire thermal exp. 
coeff.

Thermal expansion coefficient of the servo wire. Unit of 
measure is 10E-5/C (or) 10E-5/F.

Note:
Thermal expansion coefficient values in ppm (10E-6/C 
(or) 10E-6/F) needs to be converted to 10E-5/C (or) 
10E-5/F. For example, the value of 16 10E-6/C (ppm) 
needs to be converted to 1.6 and then set in Service 
tool.

Properties Description
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6. Click the Level tab, the Properties detail appears.

You can view or edit these properties:

7. Click the Water tab, the Properties detail appears.

You can view or edit these properties:

Properties Description
Level enabled Check to enable level scan.

Negative level enabled Check to enable the option. This selection is only possi-
ble for gauge types 854, 872, 873, 894 and 954.

0.1 mm level resolution Check to enable the option. This selection is only possi-
ble if the level engineering unit is set to ‘m’ or ‘mm’ and 
if the gauge type is not 811, 813, 866 or 872.

No alarm when gauge in 
test

Check to disable gauge alarms during operational com-
mands.

Level address Enter level transmission address.

Level TOI Select B, C, E, or M*.

Level TOR Select B, ZLQ or L (the combination of level TOR
‘ZLQ’ and level type ‘Ullage’ is not possible. With level 
type ‘Ullage’, use level TOR ‘L’)*.

* Refer to TABLE 3-1 for additional information.

Properties Description
Water probe enabled Check to enable water level scan from external probe.
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8. Click the Temperature tab, the Properties detail appears.

You can view or edit these properties:

Water dip enabled Check to enable water level scan from servo gauge.

Water dip offset Enter water level offset.

Minimum water level Enter minimum water level. This value is used when
no water level is found.

Water address Enter water level transmission address.

Water TOI Select B, C, E, or M*.

Water TOR Select M, J, B, L or ZLQ

Water in foreground scan Check to enable the option.

* Refer to TABLE 3-1 for additional information.

Properties Description
Temperature enabled Check to enable product temperature scan.

Element type Select No element available, MRT, MRT with bottom
spot, MRT with bottom and top spot, One spot
element, Two spot element or MTT.

Lowest element 
Position

Enter lowest temperature element position.

Temperature address Enter product temperature transmission address.

Temperature TOI Select: B, C, E, or M*.

Temperature TOR Select: C or ZAG*.

Temperature in fore-
ground scan

Check to enable the option.

Temperature profile scan 
enable

This parameter enables / disables the temperature pro-
files data collection from a BPM gauge by CIU.
When this option is selected, CIU collects temperature 
profiles data from the BPM gauge that is configured for 
product temperature.
Note: CIU would collect the temperature profile data 
from the gauge from which product temperature is 
scanned.

Properties Description
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NOTE: How to configure scan period for gauges in a Field Port.

For each temperature profile scan, CIU 888 reserves a time period of 3
minutes so that enough field port bandwidth is given for scanning periodic
foreground and background measurement items.

When the user enables temperature profile scan for a tank through “CIU 888
Service tool” or “Modbus host system” the CIU 888 Service tool runs the
following logic to determine whether the temperature profile scan enable can
be accepted or not without affecting the regular periodic scan items
(foreground and background).

Temperature profile scan enable is allowed if the available slots is greater than
or equal to 0.

Available slots = Total slots – ((Number of frames / 1) * Number of Gauges
in 1st frame) - ((Number of frames / 2) * Number of Gauges in 2nd frame) -
((Number of frames / N) * Number of Gauges in Nth frame)

where

Total slots = Number of frames * (Number of slots per frame - 1)

Number of frames = Maximum_scan_period / frame interval 

Maximum_scan_period is the highest temperature profile configuration
period in that field port or field port group.

Frame interval = Number of slots per frame * 3

Number of slots per frame = Minimum_scan_period / 3

Minimum_scan_period = smallest temperature profile scan period in that
field port or field port group

Number of Gauges in Nth frame = (configuration period / (Frame Interval * N))

Examples:

a) Field port has 3 gauges with 15 minutes as temperature profile scan period
and the user enables one more gauge for temperature profiles scan with
scan period as 15 minutes.

number of slots = 15/3 = 5

frame interval = 5 * 3 = 15

number of frames = 15/15 = 1

total slots = 1 * (5-1) = 4

number of gauges that comes once in one iteration i.e, gauges with configu-
ration period between 15 and 29 = 4 

available slots = 4 - (1*4) = 0

The CIU 888 accepts the temperature profile scan enable for the 4th gauge.

Temperature profile scan 
period

This parameter defines the time period within which the 
temperature profile data needs to be collected from a 
BPM gauge. The scan period is defined in terms of min-
utes.

* Refer to TABLE 3-1 for additional information.

Properties Description
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If one more gauge (5th) is enabled for temperature profiles with scan period
as 15.

Available slots = 4 - (1*5) = -1 which is not acceptable and CIU 888 does not
allow temperature profile scan enable for the 5th gauge. In this case, the
user needs to disable the tank profiles scan for a gauge that is of no interest
that point in time and enable the tank of interest.

b) Field port has 1 gauge with 15 minutes as temperature profile scan period,
5 gauges with 30 minutes as temperature profile scan period and the user
enables one more gauge for temperature profiles scan with scan period as
30 minutes.

number of slots = 15/3 = 5 

number of frames = 30/15 = 2

total slots = 2 * (5 -1) = 8

number of gauges that comes once in one iteration i.e, total number of
gauges with configuration period between 15 and 29 are = 1

Number of gauges that comes once in 2 iterations i.e, total number of
gauges with configuration period between 29 to 44 are = 6

Available slots = 8 - (2*1) - ((2/2)*6) = 0

The CIU 888 accepts the temperature profile scan enable for the 7th gauge.

If one more gauge (8th) is enabled for temperature profile scan then the CIU
888 does not allow temperature profile scan enable for the 8th gauge. In this
case, the user needs to disable the tank profiles scan for a tank that is of not
interest that point in time and enable the tank of interest.

9. Click the Density tab, the Properties detail appears.

You can view or edit these properties: 

Properties Description
HIMS (HTMS) enabled Check to enable density scan from HIMS

configuration.

Density dip enabled Check to enable density scan from servo gauge.

Min dip level Enter minimum density level.

Density address Enter density transmission address.

Density TOI Select: B, C, or E*.

Density TOR Select: ZQQ*.
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10.Click the Vapour Pressure tab, the Properties detail appears.

You can view or edit these properties:

Density in foreground
scan

Check to enable the option.

DP data invalidate time-
out

This is a configurable time period after which the sys-
tem will set the density profile related entities to invalid

* Refer to TABLE 3-1 for additional information.

Properties Description
Vapour temp & pressure 
enabled

Check to enable vapour pressure scan.

Pressure Type:

Absolute pressure Select if applicable.

Relative pressure Select if applicable.

Pressure address Enter vapour pressure transmission address.

Pressure TOI Select: B, C, E, or M*.

Pressure TOR Select: ZP3*.

Vapour Pressure in fore-
ground
scan

Check to enable the Pressure in foreground
scan.

* Refer to TABLE 3-1 for additional information.

Properties Description
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11.Click the Vapour Temperature tab, the Properties detail appears.

You can view or edit these properties:

12.Click the Product Pressure tab, the Properties detail appears

You can view or edit these properties:

Properties Description
Vapour temp. & pressure 
enabled

Check to enable Vapour temp. & pressure scan

Vapour temp. address Enter vapour pressure transmission address.

Vapour temp. TOI Select the Type of Instrument: B, C, E, or M*.

Vapour temp. TOR Select the Type of Record for the Vapour Temperature 
measurement: C or ZAG*.

Vapour temp. in 
foreground scan

Check to enable the Vapour temp. in 
foreground scan.

* Refer to TABLE 3-1 for additional information.

Properties Description
Product pressure 
enabled

Check to enable product pressure scan.

Product Pressure Type:

Absolute pressure Select if applicable.
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13.Click the Floating Roof Level tab, the Properties detail appears.

You can view or edit these properties:

Relative pressure Select if applicable.

Pressure address Enter product pressure transmission address.

Pressure TOI Select: B, C, E, or M*.

Pressure TOR Select: ZP1*.

Product Pressure in fore-
ground
scan

Check to enable the Pressure in foreground
scan.

* Refer to TABLE 3-1 for additional information.

Properties Description
Floating Roof Enabled Check to enable floating roof levels scan.

Floating Roof Level 
address

Enter floating roof level transmission address.

Floating Roof level 1 TOI The TOI of the first floating roof level (B)

Floating Roof level 1 
TOR

The TOR of the first floating roof level (ZHN)

Floating Roof level 2 TOI The TOI of the second floating roof level (B)

Floating Roof level 2 
TOR

The TOR of the second floating roof level (ZHO)

Floating Roof level 3 TOI The TOI of the third floating roof level (B)

Floating Roof level 3 
TOR

The TOR of the third floating roof level (ZHP)

Floating roof level in fore-
ground
scan

Set the floating roof to be scanned in the foreground or 
background. Default background.

CAUTION:
Setting Floating roof levels scan in foreground would 
have impact on the product level and other measure-
ments scan rate.

* Refer to TABLE 3-1 for additional information.

Properties Description
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14.Click the Units of Measurement tab, the Properties detail appears.

You can view or edit these properties:

NOTE: Make sure that Gauge Units of Measurement matches with the Units of
Measurement configured in the gauge. Default gauge Units of Measurement
are based on the configured global Units of Measurement.

TABLE  3-1 Special Characters

Properties Description
Level Select m, mm, ft, in, in/16, fis, or 1/256 in.

Temperature Select °C or °F

Vapour Pressure Select kgf/cm2, Pa, kPa, psi, psi_r100, or psi_r1000

Water Select m, mm, ft, in, in/16, fis, or 1/256 in.

Density Select kg/m3, °API, lbs/ft3, RD60, or lbs/US gal.

Vapour Temperature Select °C or °F

Product Pressure Select kgf/cm2, Pa, kPa, psi, psi_r100, or psi_r1000

Special Characters Description
TOI A = 802/812 gauge.

B = 811 gauge with GPU protocol and devices with 
gauge type=B.

C = 813 MGT and devices with gauge type=C.

E = 811 gauge with external alarms and devices with 
gauge type=E.

M = 816 /818.
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3.2.10.2 Configuring Dual Gauges

The CIU 888 supports collection of Product Level data from an
additional BPM gauge and this data is exposed to its Modbus output
(Modbus RTU and Modbus TCP/IP) based on the configuration. Using
this mechanism, any Modbus host system can get the data from CIU
888 and visualize it in its user interface.

To add an additional level gauge to a tank, a GPU data-input should be
configured again as described in Section 3.2.10.1 . The additional
gauge only supports configuration of Level parameter. Configuration of

TOR B = Alarm status + [contact status] if TOI is C or E + 
product level.

C = Alarm status + [contact status] if TOI is C or E + 
temperature.

J = Alarm status + water level.

L = Alarm status + [contact status] if TOI is C or E + 
signed level.

M = Water alarm status + [contact status] if TOI is C or 
E + water level status + water level record.

ZAG = Average vapour temperature (854, 873, 877, 
970, 971 & 973 only).

ZLQ = Innage servo level (854 only).

ZQQ = Abbreviated hydrostatic density (854, 866, 873, 
877, 970, 971 & 973 only).

ZP3 = Pressure sensor P3 (854, 866, 873, 877, 970, 
971 & 973 only).

ZP1 = Pressure Sensor P1 (854, 866, 873, 877, 970, 
971 & 973 only) 

Special Characters Description
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other parameters (Water, Temperature, Density etc.) and gauge
commands is disabled.

FIGURE  3-34 Dual gauges configured

FIGURE  3-35 Gauge level parameter can be configured
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3.2.10.3 Modbus Data Input

1. On the CIU 888 node, right-click and choose Import MODBUS
device type file.

NOTE: Modbus device configuration file for Honeywell Smartline level transmitter
SLG700 is available by default in the CIU 888 Service tool. For new field
device, import its Modbus device configuration file to the CIU 888 Service tool.

2. Device Type- CIU 888 Service Tool window appears.

3. Select the XML of the Modbus device and click Open.
The details of the specified XML file are loaded.

Refer to Appendix H for the creation of a new Modbus field device
configuration file.
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4. On the Tank node, right-click and choose Add > Modbus Data
Input.

5. The Add Site Element window appears.

6. In the Name box, type the name of the Modbus Data Input and click
OK.

7. The M1 node is created and displayed under Tank1
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You can view or edit these properties.

Properties Description
DeviceGPUAddress This indicates the GPU address of the Honeywell TRL2 

field device.

CIU Parameter This indicates the CIU parameter name to which the 
scanned Modbus field device parameter has to be 
mapped. CIU Service tool displays all the CIU Parame-
ters which can be scanned from Modbus field devices in 
a drop down menu.

Device Type This is the Modbus field device type. For example, this 
can be Smartline Level Transmitter, E+H ProServo. CIU 
Service tool displays all the supported device types in a 
drop down menu.

Device Slave ID Each Modbus device is addressed with a unique slave 
ID. That is, when a request is received by a Modbus 
device, it checks the Modbus slave ID in the request 
and if it matches with its configured slave ID, it 
responds back, else it skips the request. This indicates 
the Modbus RTU address of the field device.

Device Modbus Start 
Address

This parameter indicates the address from where the 
Modbus mapping starts for a device. In case of Modbus 
field devices that are directly connected to CIU this 
could be 0 and in case of Modbus data concentrator, 
the user has to configure it based on the device number 
in the Modbus data concentrator. For example, for E+H 
ProServo Modbus field device, this value could be 0 
and for Smartline Level Transmitter connected as sec-
ond HART device to a HCS Modbus-HART converter, 
this value could be 264.

Device Parameter Name This indicates the name of the parameter in the Modbus 
field device which needs to be scanned by CIU. This 
parameter would be used by CIU to interpret data in 
case of custom value mapping.

Modbus Register 
Address

This indicates the relative Modbus address of the 
selected parameter.
Absolute Modbus address of Parameter = Device Mod-
bus Start Address + Modbus Register Address

Scan Priority This indicates the scanning priority for a device parame-
ter. This can be configured as Foreground / Back-
ground. While scanning the field device, if multiple field 
device parameters are retrieved in one Modbus 
request, then highest priority within the scanned field 
device parameters is set for that request. 
For example, if Product Level (Foreground priority), 
Product Temperature (Background priority), Product 
Density (Background priority) are retrieved from the 
field device with a single Modbus request, then the 
Modbus request would be scheduled to the field with 
Foreground priority.
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3.2.10.4 TRL/2 Data Input

The CIU 888 collects measurement data like Product level, Product
temperature etc., from the TRL2 gauges and exposes the data in its
Modbus output (Modbus RTU and Modbus TCP/IP) based on the
configuration. Using this mechanism any Modbus host system can get
the data from CIU 888 and visualize it in its user interface. 

The CIU 888 also collects temperature profiles data from the TRL2
gauges and exposes the data in its Modbus output (Modbus RTU and
Modbus TCP/IP) based on the configuration. The CIU 888 collects data
for a maximum of 14 temperature elements. Using this mechanism any
Modbus host system can get the temperature profiles data from CIU
888 and visualize the data in its user interface. 

The following steps detail out the configuration procedure.

1. On the CIU 888 node, right-click and choose Import TRL/2 device
type file.

NOTE: TRL2 device configuration file for Honeywell Radar TRL2 gauge, Rex RTG
gauge, SDAU2100, Honeywell VITO are available by default in the CIU 888
Service tool. For new field device, import its TRL2 device configuration file to
the CIU 888 Service tool.

Device Engineering Unit This indicates the unit in which data is exposed by the 
Modbus field device. For example, E+H ProServo Mod-
bus field device can expose "Liquid Level" parameter in 
5 different units (mm, cm, m, ft, inch) and the user has 
to select the appropriate device unit based on the Mod-
bus field device configuration.

Properties Description
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2. Device Type- CIU 888 Service Tool window appears.

3. Select the XML of the TRL/2 device and click Open.
The details of the specified XML file are loaded.

Refer to Appendix H for the creation of a new TRL/2 field device
configuration file.

4. On the Tank node, right-click and choose Add > TRL/2 Data Input.

5. The Add Site Element window appears.

6. In the Name box, type the name of the TRL/2 Data Input and click
OK.
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7. The G1 node is created and displayed under Tank T1.

You can view or edit these properties.

Properties Description
DensityCalculationType This parameter indicates the HIMS density calculation 

type.

P1SensorPosition The position of the center of the Liquid Pressure sensor 
membrane. This is expressed in m.

P3SensorPosition The position of the center of the Vapor Pressure sensor 
membrane. This is expressed in m.

HybridMinLevel This value specifies the lowest product level at which 
the Observed Density would be calculated.

CIU Parameter This indicates the CIU parameter name to which the 
scanned TRL/2 field device parameter has to be 
mapped. CIU Service tool displays all the CIU Parame-
ters which can be scanned from TRL/2 field devices in a 
drop down menu.

Device Type This is the TRL/2 field device type. For example, 
Emersion Rex, Honeywell TRL/2 Gauge. CIU Service 
tool displays all the supported device types in a drop 
down menu.

Device Slave ID Each TRL/2 device is addressed with a unique slave ID. 
That is, when a request is received by a Modbus 
device, it checks the TRL/2 slave ID in the request and 
if it matches with its configured slave ID, it responds 
back, else it skips the request. This indicates the TRL/2 
RTU address of the field device.



Getting Started

Part No.: 4417584_Rev12 Configuration Manual
CIU 888 3 - 83

Device GPU Address This indicates the GPU address of the Honeywell TRL2 
field device.

Device Flexconn Address This indicates the Flexconn address of the Honeywell 
TRL2 field device.

Device Modbus Start 
Address

This parameter indicates the address from where the TRL/
2 mapping starts for a device. In case of TRL/2 field 
devices that are directly connected to CIU this could be 0 
and in case of TRL/2 data concentrator, the user has to 
configure it based on the device number in the TRL/2 data 
concentrator. For example, TRL/2 data concentrators.

Device Parameter Name This indicates the name of the parameter in the TRL/2 
field device which needs to be scanned by CIU. This 
parameter would be used by CIU to interpret data in 
case of custom value mapping.

Modbus Register 
Address

This indicates the relative TRL/2 address of the 
selected parameter.
Absolute TRL/2 address of Parameter = Device TRL/2 
Start Address + TRL/2 Register Address

Scan Priority This indicates the scanning priority for a device parameter. 
This can be configured as Foreground / Background. 
While scanning the field device, if multiple field device 
parameters are retrieved in one TRL/2 request, then high-
est priority within the scanned field device parameters is 
set for that request. 
For example, if Product Level (Foreground priority), Prod-
uct Temperature (Background priority), Product Density 
(Background priority) are retrieved from the field device 
with a single TRL/2 request, then the TRL/2 request would 
be scheduled to the field with Foreground priority.

Device Engineering Unit This indicates the unit in which data is exposed by the 
TRL/2 field device. For example, E+H ProServo TRL/2 
field device can expose "Liquid Level" parameter in dif-
ferent units (example: mm, cm, m, ft, inch) and the user 
has to select the appropriate device unit based on the 
TRL/2 field device configuration.

Temperature profile scan 
enable

This parameter enables / disables the temperature pro-
files data collection from a BPM gauge by CIU.
When this option is selected, CIU collects temperature 
profiles data from the BPM gauge that is configured for 
product temperature.
Note: CIU would collect the temperature profile data 
from the gauge from which product temperature is 
scanned.
Note: If the temperature profile is enabled, then the 
Scan Period, SlaveID, Modbus Address and Device 
Type must be configured for temperature profiles to be 
collected from the gauge.

Temperature profile scan 
period

This parameter defines the time period within which the 
temperature profile data needs to be collected from a BPM 
gauge. The scan period is defined in terms of minutes.

Properties Description
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3.2.11 Configuring a Host port
1. On the CIU 888 node, click Host port 1.

2. By default, the Host port tab appears.

You can view or edit these properties:

Properties Description
Device Name Two serial host ports are available by default and 

device name is fixed for them. For new Host ports 
created, the user has to select appropriate option slot.

Host Port Configuration 
name

It is a user friendly configuration name.

Physical Layer Select RS-232C or RS-485 (default = RS-232C).
Note: If ‘RS-232C’ is selected, while in reality RS-485 
hardware is applied, communication cannot be 
established.

Baud rate Select 1200, 2400, 4800, 9600, 19200 or 38400 (default 
= 19200).

Data bits Select 7 or 8 (default = 8).

Stop bits Select 1 or 2 (default = 1).

Parity Select Odd, Even, or None (default = Odd).

Duplex mode Select Full or Half (default = Full).

Turn around delay Enter reply waiting time in ms (default = 20 ms).

RTU address Enter the RTU address in the range 1 through 247 
(default= 41).
Note: Each RTU address must be unique in the site.

Protocol Type Select None, Modbus RTU, or CIU-GPU (default = None).
Modbus RTU shall be selected if data needs to be 
presented to Modbus Hosts like Entis Pro, PLC etc and ser-
vice tool like Tankmaster Winsetup connects to CIU 888.
CIU-GPU shall be selected if data needs to be 
presented to GPU clients like Entis XL, profiling tools 
like Entemp etc., In this case, the host port would be 
configured for CIU Emulation.
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Modbus Mode When host port is configured for Modbus RTU protocol, 
Modbus Mode property indicates the operation mode 
for the host port.
Note: Refer to the Protocol Manual - CIU Emulation CIU 
888 (Part No. 4417589) section 3.1.2, for more information.

Modbus Mapping Select Entis Pro compliant, User specified, or CIU Plus 
compliant.
Entis Pro compliant shall be selected if Entis Pro is con-
nected to this port. All data will be filled in predefined 
positions.
CIU Plus compliant shall be selected if CIU Plus is con-
nected to this port. All data will be filled in predefined 
positions.
Note: Refer to Protocol Manual - Modbus Host (Part No. 
4417588) section 2.4, Input registers and Holding regis-
ters, for more information.
User specified shall be selected if a Modbus host like 
DCS, PLC is connected to this port. Refer to 
section 3.2.12 ‘Modbus settings’ for details how to con-
figure the Modbus map.

Absolute start address Enter start address for the User data area of CIU 888 
Modbus map (default = 0).
For Example: Change the start address to 10000 if 80 
tanks need to be supported with Entis pro compliant 
modbus map.

Suppress moving status This configuration indicates whether moving status is sup-
pressed (or) not in the CIU 888’s Modbus Tank record.

MSU mode Check to enable the option.
MSU mode is mainly for CIU emulation and is applica-
ble only when the protocol type is CIU-GPU. 
Note: Refer to the Protocol Manual - CIU Emulation CIU 
888 (Part No. 4417589) for more information.

Host port GPU cache Check to enable the option.
When GPU cache mode is enabled, the CIU 888 gets 
the data from cache (if available) and responds to GPU 
host request.

Disable ACK in CIU-GPU When this option is selected, the CIU does not send 
ACK characters to the GPU host system.

Prime compatible Mod-
bus output

Select to get the modus output in same way as CIU 880 
Prime host port.
Default: Not Selected.

Suppress moving status To ignore moving status and present in Modbus output
Default: Not Selected

Disable ACK in CIU-GPU This configuration indicates whether Moving status is 
suppressed (or) not in the CIU 888's Modbus Tank 
record.
0 = Moving status not suppressed
1 = Moving status suppressed

Properties Description
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3. Click the Secondary CIU Host tab, the Properties detail appears.

You can view or edit these properties.

3.2.12 Configuring User defined Modbus map 

The CIU 888 provides data in the Modbus area of the host ports for
consumption by external hosts. The Modbus mapping of ports not in

Prime Compatible mod-
bus output

Prime compatible modbus output
0 = Prime compatible modbus output disabled
1 = Prime compatible modbus output enabled

MSU mode CIU 888 HostPort MSU mode
0 = MSU mode off
1 = MSU mode on

Host port GPU cache CIU 888 HostPort Cache mode
0 = GPU Cache disabled
1 = GPU Cache enabled

Properties Description
Secondary RTU address Enter the RTU address in the range 1 through 247 

(default= 43).
This is the secondary CIU's Host port RTU address.
Note: Each RTU address must be unique in the site.

Properties Description
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use by the Entis Pro system can be modified to become compliant with
third party Modbus hosts as described below.

1. Click Host port 1 and change Modbus mapping as User specified.
2. Configure the absolute start address to the start of user defined

modbus area.
3. Click Apply.

A pop up window appears, Click OK.

4. On the Host port 1 node, right-click and choose User defined
modbus map.

User defined modbus map window appears.
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3.2.12.1 User defined modbus map - Tanks

The configuration settings in this tab will define the layout of modbus
data and sequence of the tanks in the modbus map.

You can view or edit these properties.

Properties Description
Data Orientation Select Tank oriented (= data grouped by tank) or Data 

oriented (= data grouped by entity).

Record interval Enter the number of registers allocated for each tank 
record
(default = 125).

Always force data output 
to fail value if validity is 
failure

Select to force the Modbus registers to invalid data, if 
the status/validity of the parameter indicates failure. If 
not selected, the last known value will be retained in the 
Modbus registers.

Available Tanks This displays all tanks that are not associated in the 
modbus map.

 Click this button to move all the tanks from ‘Available 
Tanks’ to ‘Selected Tanks’.

Click this button to move all the tanks from ‘Selected 
Tanks’ to the ‘Available Tanks’.

Click this button to move the selected tank from 
‘Available Tanks’ to ‘Selected Tanks’.

Click this button to move the selected tank from 
‘Selected Tanks’ to ‘Available Tanks’.

Click this button to move the selected tank in the 
‘Selected Tanks’ one position up.
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3.2.12.2 User defined modbus map - Entities

NOTE: The selected list of entities is shown on the right part of the entities tab, this is
referred as ‘Selected entities’ in the below description.

You can view or edit these properties.

Click this button to move the selected tank in the 
‘Selected Tanks’ one position down.

Click this button to move all the tanks to ‘Selected 
Tanks’ in the creation order.

Selected Tanks This displays tanks that are associated in the modbus 
map.

Properties Description
Available Entities This displays all entities which are not associated with 

modbus map.
This includes the list of entities provided by CIU 880 
Prime and CIU 880 Plus user defined host port Modbus 
mapping and also new entities added in CIU 888.

Click this button to move all entities in the ‘Available 
entities’ to the ‘Selected entities’

Click this button to move all entities in the ‘Selected 
entities’ to the ‘Available Entities’.

Click this button to move the selected entity in the 
‘Available entities’ to the ‘Selected entities’.

Properties Description
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3.2.12.3 User defined modbus map - Profiles

This section helps the user to configure the Temperature Profiles
Modbus area in CIU 888.

The configurable Temperature Profile fields and a brief description on
each of them are given in the following table.

Click this button to move the selected entity in the 
‘Selected entities’ to the ‘Available Entities’.

Click this button to move the selected entity in the 
‘Selected entities’ one position up.

. Click this button to move the selected entity in the 
‘Selected entities’ one position down.

Click this button to select ‘Entis Pro’ compliant entities 
in 'Selected entities'.

Definitions

Entity ID Entity ID number

Entity Name Name of the Entity

Type Modbus data type of the entity.

Size Number of Modbus registers

Scale Scaling factor

Offset Offset value

Fields Description
Temperature Profile 
Absolute Start address

This indicates the absolute start address of the tem-
perature profiles record.
Values are in decimal. Default value is 20000. Configu-
rable when modbus mapping is User Specified.

Temperature Profile 
Record Interval

This indicates the record interval of the temperature 
profiles record.
Values are in decimal. Default value is 125. Configu-
rable when modbus mapping is User Specified.

Properties Description
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NOTE: The selected list of entities is shown on the right part of the entities tab, this is
referred as ‘Selected entities’ in the below description.

You can view or edit these properties.

Properties Description
Available Entities This displays all entities which are not associated with 

modbus map.

NOTE:This includes the list of entities provided by CIU 
880 Prime and CIU 880 Plus user defined host port
Modbus mapping and also new entities added in CIU
888.

Click this button to move all entities in the ‘Available 
entities’ to the ‘Selected entities’

Click this button to move all entities in the ‘Selected 
entities’ to the ‘Available Entities’.

Click this button to move the selected entity in the 
‘Available entities’ to the ‘Selected entities’.

Click this button to move the selected entity in the 
‘Selected entities’ to the ‘Available Entities’.

Click this button to move the selected entity in the 
‘Selected entities’ one position up.

. Click this button to move the selected entity in the 
‘Selected entities’ one position down.

Click this button to select ‘Entis Pro’ compliant entities 
in 'Selected entities'.

Definitions

Entity ID Entity ID number

Entity Name Name of the Entity
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3.2.12.4 User defined modbus map - Density Profiles

This section helps the user to configure the Density Profiles Modbus
area in CIU 888.

The configurable Density Profile fields and a brief description on each of
them are given in the following table.

NOTE: The selected list of entities is shown on the right part of the entities tab, this is
referred as ‘Selected entities’ in the below description.

Type Modbus data type of the entity.

Size Number of Modbus registers

Scale Scaling factor

Offset Offset value

Fields Description
Density Profile Absolute 
Start address

This indicates the absolute start address of the density 
profiles record.
Values are in decimal. Default value is 30000
Configurable when modbus mapping is User Specified.

Density Profile Record 
Interval

This indicates the record interval of the density profiles 
record.
Values are in decimal. Default value is 320
Configurable when modbus mapping is User Specified.

Properties Description
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You can view or edit these properties.

3.2.13 Configuring Ethernet Host port

3.2.13.1 Configuring FTEA and FTEB ports

1. On the CIU 888 node, click FTEA port.

Properties Description
Available Entities This displays all entities which are not associated with 

modbus map.

NOTE:This includes the list of entities provided by CIU 
880 Prime and CIU 880 Plus user defined host port
Modbus mapping and also new entities added in CIU
888.

Click this button to move all entities in the ‘Available 
entities’ to the ‘Selected entities’

Click this button to move all entities in the ‘Selected 
entities’ to the ‘Available Entities’.

Click this button to move the selected entity in the 
‘Available entities’ to the ‘Selected entities’.

Click this button to move the selected entity in the 
‘Selected entities’ to the ‘Available Entities’.

Click this button to move the selected entity in the 
‘Selected entities’ one position up.

. Click this button to move the selected entity in the 
‘Selected entities’ one position down.

Click this button to select ‘Entis Pro’ compliant entities 
in 'Selected entities'.

Definitions

Entity ID Entity ID number

Entity Name Name of the Entity

Type Modbus data type of the entity.

Size Number of Modbus registers

Scale Scaling factor

Offset Offset value
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2. By default, FTE tab appears displaying various properties.

You can view or edit these properties.

Parameters Configuration options
Device name This indicates the device name of the Ethernet port. 

IP Address IP address of the corresponding Ethernet port in the 
CIU.

Format: a.b.c.d
Example: 10.70.100.101 

Subnet Mask Subnet mask of the corresponding Ethernet port in the 
CIU. In case of redundant CIUs, this also indicates the 
Subnet mask of the corresponding Ethernet port in the 
partner CIU.

Format: e.f.g.h
Example: 255.255.255.0

Default Gateway Default Gateway of the corresponding Ethernet port in 
the CIU. In case of redundant CIUs, this also indicates 
the default gateway of the corresponding Ethernet port 
in the partner CIU.

Format: i.j.k.l
Example: 10.79.100.1

Note: If no gateway is required, then this setting can be 
left blank.
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Transparency mode Transparency mode: When the check box is selected, 
it is said to be in Transparency mode.This indicates 
transparency behavior of the Ethernet port. This setting 
is applicable only to the redundant CIUs.
In this mode, CIU binds the IP address to Ethernet port 
based on the current redundancy role.

• Primary CIU binds to its IP address during active or 
passive state when all the Ethernet links (marked 
for IP Switch over decision maker) of the Secondary 
CIU is down.

• Primary CIU binds to Secondary CIU's IP address 
during passive state when atleast one of the 
Ethernet links (marked for IP Switch over decision 
maker) of the Secondary CIU is up.

• Secondary CIU binds to its IP address during 
passive state when atleast one of the Ethernet links 
(marked for IP Switch over decision maker) of the 
Primary CIU is up.

• Secondary CIU binds to Primary CIU's IP address 
during active or passive state when all the Ethernet 
links (marked for IP Switch over decision maker) of 
the Primary CIU is down.

IP switch over decision 
maker

This option is applicable only for redundant CIUs and is 
required for the host initiated switchovers to work prop-
erly since CIU doesn't support autonomous switchovers 
This indicates whether Active CIU's Ethernet port status 
is monitored by the Passive CIU to make IP switchover 
decision.

If all the ports selected for "IP Switchover Decision 
Maker" in Active CIU goes down (that means the Mod-
bus TCP/IP Host system cannot communicate to active 
CIU), then Passive CIU's Ethernet port's bind to Pri-
mary CIU's Ethernet port address.

In case of Multiple host systems connected to CIU, we 
need to select this option for the Ethernet ports where 
the client host system (that can read, write data to CIU 
and issue switchover command) is connected. 

For example a site has ExperionPKS connected to 
FTEA and FTEB ports and a third party Modbus TCP/IP 
host system connected to LAN port and ExperionPKS 
is the client host system (Issues switchover command 
to CIU). In this case, FTEA and FTEB ports need to 
selected for "IP Switchover Decision Maker" and LAN 
port is deselected for "IP Switchover Decision Maker". 
In this case, if both FTEA and FTEB links of Active CIU 
goes down, then Passive CIU's FTEA and FTEB ports 
bind to the Primary CIU's IP address so that Host Sys-
tem (ExperionPKS) can issue an ACTIVE CIU com-
mand and make the CIU as Active and continue its 
operations.

Parameters Configuration options
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Modbus Server Enable This indicates enable / disable of the Modbus TCP 
Server on the Ethernet port. That is, based on the need 
the user shall enable / disable Modbus TCP/IP server 
on a particular Ethernet port.

Modbus Port Number This indicates the software port number in which Mod-
bus server would be enabled. The default port number 
is 502.

Secure Modbus server 
enable

This would enable / disable the secure Modbus TCP 
Server on the ethernet port.
0 - Modbus TCP/IP server disabled
1 - Modbus TCP/IP server enabled

Modbus Server Protocol 
Type

This indicates the Modbus server protocol type.
Supported protocols are
Modbus TCP/IP

Modbus Server Idle time-
out 

This indicates the idle time period (no Modbus mes-
sage exchanges) in seconds after which a client con-
nection would be closed by the Modbus TCP/IP server.
Value is from 10 to 65535. Default is 60.

IP filtering This enables / disables IP address filtering by the Mod-
bus TCP/IP server.  If enabled, Modbus TCP/IP server 
only accepts connections from the IP addresses / range 
configured in "IP addresses / Range" option.

Allowed IP Addresses / 
Range

This indicates the IP address list (IP addresses / range) 
from which connection is accepted by the Modbus TCP 
server. Client connections from any other IP addresses 
apart from that configured here would be rejected by 
the Modbus TCP/IP server.
The user shall be able to configure multiple IP 
addresses / ranges.
IP addresses Format: IP addresses separated by 
comma. 

Example: 10.70.50.3,10.70.50.5,10.70.50.10
IP address ranges Format: IP address range is speci-
fied with "-" and multiple IP address ranges are sepa-
rated by comma.
Example: 10.70.50.3-10.70.50.7,10.70.50.100-
10.70.50.105

Unit Id Filtering This enables / disables Unit Id (Unit identifier) filtering 
by the Modbus TCP/IP server. If enabled, Modbus 
TCP/IP server only responds to Modbus requests with 
Unit Id (Unit Identifier) from the Unit Id list configured in 
"Unit Ids" option.

Parameters Configuration options
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Allowed Unit IDs This indicates the Unit Id (Unit Identifier) list for which 
Modbus TCP/IP server should respond. Modbus 
requests with any other Unit Id apart from that config-
ured here would be ignored and not responded by the 
Modbus TCP/IP server.

Example: 1,2,3,4,5
Multiple Unit IDs are separated by commas.

Field Scan enable This would enable / disable the Modbus TCP Server on 
the ethernet port.
0 - Modbus TCP/IP server disabled
1 - Modbus TCP/IP server enabled

Field Scan IP address The IP address of a CIU 888 TCP/IP host port

Field Scan port number The IP port number for the modbus host port (which is 
502 by default).

Turn around delay Ensite Pro com port turn around delay.
0-65535 msec

This entity, stored in the global area of a site database, 
is for internal use only.
Ensite Pro will not download this entity to any CIU.

Time-out CIU Prime FieldPort time-out.
0-65535 msec

CIU 888
EGDS Device Message parameter. With the message 
timeout the time to receive data from the device that will 
be called can be set. This timeout can be set in millisec-
onds. If the site server (EGDS) sends a

Retries This entity was originally defined for the number of 
retries on the FieldPort.  
However the software of the CIU has implemented dif-
ferently. Imagine a tank, with number of retries set to 
five, does not answer. This tank will decrease the scan 
performance

Communication fail delay When a field communication fail occurs it is possible to 
maintain last valid scan data in the CIU 888 database 
during a configurable amount of time.
Minimum time to mask a field communication fail: 0 sec 
(delay mechanism disabled).
Maximum time to mask a 

Data fail delay When a field data fail occurs it is possible to maintain 
last valid scan data in the CIU 888 database during a 
configurable amount of time. 
Minimum time to mask a field data fail: 0 sec (delay 
mechanism disabled).
Maximum time to mask a field data fail: 

OPC UA server enable This setting would enable / disable the OPC UA Server 
on the CIU 888's ethernet port (FTEA / FTEB).
0 - OPC UA server is disabled
1 - OPC UA server is enabled

Parameters Configuration options
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3. Click the Secondary FTE Host Port tab to view the Property.

You can view or edit this property.

NOTES: 1. If configuring for Experion network, both FTE A and FTEB should be in 
same subnet. 

2. If configuring in non-redundancy mode, then Transparency and IP 
switchover decision maker should be disabled. 

3.2.13.2 Configuring LAN port

1. On the CIU 888 node, click LAN port.

Server URL This setting depicts the server URL. The OPC UA cli-
ents to CIU 888 using this URL. The URL shall be in the 
below format.
opc.tcp://192.168.20.10:51000

Default value: Empty string

Parameter Configuration option
Secondary IP Address In case of redundant CIUs, this indicates the IP address 

of the corresponding Ethernet port in the partner CIU.

Format: w.x.y.z
Example: 10.70.100.102

Parameters Configuration options
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2. By default, LAN tab appears displaying various Properties.

You can view or edit these properties.

Parameters Configuration options
Device name Actual device name of the service port (generated by 

the driver component of the CIU 888 firmware)

IP Address The IP address of a CIU 888 TCP/IP host port

Subnet Mask The subnet mask of a CIU 888 TCP/IP host port

Default Gateway The default gateway of a CIU 888 TCP/IP host port

Transparency mode This entity indicate transparency behaviour of the CIU 
888 host port.
0 => No transparency mode. RTU address is fixed.
1 => Transparency mode. RTU address is dynamic 
based on the redundancy role.

IP switch over decision 
maker

This entity indicates whether the ethernet interface is 
involved in IP address switchover decision (or) not.
That is, these ports would be monitored by the passive 
CIU and IP address binding to Primary CIU's IP 
addresses would happen in case of failure of

Modbus Server Enable This would enable / disable the Modbus TCP Server on 
the ethernet port.
0 - Modbus TCP/IP server disabled
1 - Modbus TCP/IP server enabled

Modbus Port Number The IP port number for the modbus host port (which is 
502 by default).

Secure Modbus server 
enable

This would enable / disable the secure Modbus TCP 
Server on the ethernet port.
0 - Modbus TCP/IP server disabled
1 - Modbus TCP/IP server enabled

Modbus Server Protocol 
Type

This indicates the Modbus server protocol type. Sup-
ported types:
1 - Modbus TCP/IP 
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Modbus Server Idle time-
out 

This indicates the idle time period in seconds after 
which a client connection would be closed by the Mod-
bus TCP server.

IP filtering This would enable/disable IP filtering. If enabled, CIU 
888 would accept the connections from only configured 
IP addresses / IP address range
0 - IP address filter is disabled 
1 - IP address filter is enabled

Allowed IP Addresses This indicates the IP addresses from which connection 
is accepted by the CIU 888's Modbus TCP server. The 
IP addresses are given with a comma separation. For 
example, 192.168.1.11,192.168.1.12

Allowed IP Range This indicates the IP address ranges from which con-
nection is accepted by the CIU 888's Modbus TCP 
server. The IP address ranges are given with a comma 
separation. For example, 192.168.1.10-
192.168.1.15,192.168.1.25-192.168.1.35

Unit Id Filtering This indicates if Modbus Unit ID filtering is to be 
enabled/disabled in CIU 888.
0 - Modbus Unit ID filter is disabled
1 - Modbus Unit ID filter is enabled

Allowed Unit IDs This indicates the Modbus unit Ids for which CIU 888's 
Modbus server would respond with data.

Field Scan enable This would enable / disable the Modbus TCP Server on 
the ethernet port.
0 - Modbus TCP/IP server disabled
1 - Modbus TCP/IP server enabled

Field Scan IP address The IP address of a CIU 888 TCP/IP host port

Field Scan port number The IP port number for the modbus host port (which is 
502 by default).

Turn around delay Ensite Pro com port turn around delay.
0-65535 msec

This entity, stored in the global area of a site database, 
is for internal use only.
Ensite Pro will not download this entity to any CIU.

Time-out CIU 888 HostPort time-out.
0-65535 msec

Retries This entity was originally defined for the number of 
retries on the FieldPort.  
However the software of the CIU has implemented dif-
ferently. Imagine a tank, with number of retries set to 
five, does not answer. This tank will decrease the scan 
performance

Parameters Configuration options
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Refer to the parameters and configuration options in LAN tab under
LAN A port given in section 3.2.10.1 for more information.

3. Click the Secondary LAN Port tab to view the Property.

You can view or edit this property.

Communication fail delay When a field communication fail occurs it is possible to 
maintain last valid scan data in the CIU 888 database 
during a configurable amount of time.
Minimum time to mask a field communication fail: 0 sec 
(delay mechanism disabled).
Maximum time to mask a 

Data fail delay When a field data fail occurs it is possible to maintain 
last valid scan data in the CIU 888 database during a 
configurable amount of time. 
Minimum time to mask a field data fail: 0 sec (delay 
mechanism disabled).
Maximum time to mask a field data fail: 

OPC UA server enable This setting would enable / disable the OPC UA Server 
on the CIU 888's ethernet port (LAN).
0 - OPC UA server is disabled
1 - OPC UA server is enabled

Server URL This setting depicts the server URL. The OPC UA cli-
ents to CIU 888 using this URL. The URL shall be in the 
below format.
opc.tcp://192.168.20.10:51000

Default value: Empty string

Parameter Configuration option
Secondary IP Address In case of redundant CIUs, this indicates the IP address 

of the corresponding Ethernet port in the partner CIU. 

Format: w.x.y.z
Example: 10.70.100.102

Parameters Configuration options
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Refer to the parameters and configuration option in Secondary LAN
Port tab under LAN A port given in section 3.2.10.1 for more infor-
mation.

NOTES: 1. In Experion PKS integration via FTE network, FTE A and FTE B should be 
in same subnet and LAN should be in different subnet.

2. In other host system integration, FTE A, FTE B and LAN should be in 
different subnets.

3.2.13.3 Configuring VPN Port

1. On the CIU 888 node, click VPN port.
2. By default, VPN tab appears displaying various properties.

You can view or edit these properties.

Parameters Configuration options
Device name This indicates the device name of the VPN port. 

VPN port IP Address IP address of the corresponding VPN port in the CIU.

Format: 192.168.x.x, 10.x.x.x, 172.16.x.x to 172.31.x.x
Default Value: 192.168.5.1

Note: Following IP series are invalid 
         192.168.1.x, 192.168.10.x

VPN Subnet Mask Subnet mask of the corresponding VPN port in the CIU. 
In case of redundant CIUs, this also indicates the Sub-
net mask of the corresponding VPN port in the partner 
CIU.

Format: e.f.g.h
Default Value: 255.255.255.0
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3. Click the Secondary VPN Port tab to view the Property.

You can view or edit this property.

3.2.14 Configuring Modbus map for TCP/IP ports

CIU 888 node provides the option to create, edit and delete TCP/IP
modbus maps. 

3.2.14.1 Create TCP/IP Modbus Map

1. On the CIU 888 node, right-click and select Create TCP/IP modbus
map from the menu.

Parameter Configuration option
VPN port counterpart IP 
Address

In case of redundant CIUs, this indicates the IP address 
of the corresponding Ethernet port in the partner CIU. 
CIU Service tool shall have a provision to get the same 
from user. 

Format: 192.168.x.x, 10.x.x.x, 172.16.x.x to 172.31.x.x
Default Value: 192.168.5.1

Note: Following IP series are invalid 
         192.168.1.x, 192.168.10.x
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2. The New TCP/IP Modbus Map window appears.

3. The two fields seen in the window and a brief description of each of
them are as follows:
 Modbus Configuration Name - This indicates the Modbus

configuration name. This shall be used to identify a Modbus map
configuration for a Modbus TCP/IP client.

 Unit ID - This indicates the Unit Id (Unit Identifier) list for which
Modbus TCP/IP server should respond. Modbus requests with
any other Unit Id apart from that configured here would be ignored
and not responded by the Modbus TCP/IP server. It is value from
1 - 254.

4. Enter appropriate details in each of the fields and click OK
The ModbusMapSettings window appears
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5. The various fields seen in the window and a brief description on each
of the them are given in the following table.

Fields Description
Modbus Configuration 
Name

This indicates the Modbus configuration name. This 
shall be used to identify a Modbus map configuration for 
a Modbus TCP/IP client.

Unit ID This refers to the unit identifier in case of the Modbus 
TCP/IP client request. Different Modbus maps should 
have unique unit identifier configured so that when a 
Modbus TCP/IP client requests with a Unit Identifier, 
CIU shall pick up the corresponding Modbus map and 
present the data accordingly.

Turn around Delay This refers to the CIU’s response to any Modbus 
requests after the specified turn around delay in milli 
seconds. 
Value is from 0 to 65535. Default value is 20.

Modbus mapping This indicates the Modbus mapping type. Supported 
types are: 
• Entis Pro Complaint
• User specified 
• CIU Plus Complaint 
• ENTIS Compliant
For more information on User specified modbus maps, 
refer to section 3.2.12.1 and section 3.2.12.2
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6. Enter the details as required and click Apply.

NOTE: Click the Apply button after filling details in Tanks, Entities, Temperature
Profiles and Density Profiles tab.

3.2.14.2 Delete TCP/IP Modbus map

On the CIU 888 node, right-click and select Delete exisiting TCP/
IP modbus map from the menu.

Absolute start address This indicates the absolute start address of the Modbus 
tank record.
Values are in decimal.
Note: For Entis Pro and ENTIS Complaint Modbus 
mapping, if the number of tanks are more than 50 then 
configure absolute start address as 10000.

Temperature Profile Abso-
lute Start address

This indicates the absolute start address of the tem-
perature profiles record.
Values are in decimal. Default value is 20000. Configu-
rable when modbus mapping is User Specified.

Temperature Profile 
Record Interval

This indicates the record interval of the temperature 
profiles record.
Values are in decimal. Default value is 125. Configu-
rable when modbus mapping is User Specified.

Density Profile Absolute 
Start address

This indicates the absolute start address of the density 
profiles record.
Values are in decimal. Default value is 30000.
Configurable when modbus mapping is User Specified.

Density Profile Record 
Interval

This indicates the record interval of the density profiles 
record.
Values are in decimal. Default value is 320.
Configurable when modbus mapping is User Specified.

Fields Description
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1. The Delete TCP/IP Modbus Map window appears.

2. Select the name of the Modbus map to be deleted from the drop-
down list and click OK.

The Modbus map is deleted.

3.2.14.3 View/Edit Modbus TCP/IP Maps

1. On the CIU 888 node, right-click and select View / Edit TCP/IP
modbus map from the menu.

2. The View/Edit TCP/IP Modbus Map window appears.

3. Select the name of the modbus map to be viewed from the drop-
down list and click OK.
The ModbusMapSettings window is displayed for viewing and
editing.
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3.3 Sending Configuration to CIU 888

1. On the CIU 888 node, right-click and choose Send configuration to
CIU 888.

2. The CIU 888 Connection Details window appears.

3. In the Service Port address box, type the name of the service port
address.

4. In the User name box, type the User name.
5. In the Password box, type the password.
6. In the Configuration box, select the New Configuration or update

configuration.
7. Click Send Configuration to CIU 888.

Click the apply button to save changes before navigating to other tabs. Failing to do so may 
lead to wrong values getting displayed.
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3.4 Generating INI Files

1. On the CIU 888 node, right-click and choose Send configuration to
CIU 888.

2. The CIU 888 Connection Details window appears.

3. In the Service Port address box, type the name of the service port
address.

4. In the User name box, type the User name.
5. In the Password box, type the password.
6. Click Generate INI Files.
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3.5 Verifying Configuration

1. On the CIU 888 node, right-click and choose Send configuration to
CIU 888.

2. The CIU 888 Connection Details window appears.

3. In the Service Port address box, type the name of the service port
address.

4. In the User name box, type the user name.
5. In the Password box, type the password.
6. Click Verify Configuration.
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3.6 Importing an existing site configuration

1. From the CIU 888 Service Tool window, Choose File > Open.

The SelectSiteForm window appears.

2. Click Import.

3.6.1 Recommended actions if importing from prior to R150.1 Databases
 If CIU Plus compliant modbus maps are configured in TCP/IP, then

delete and re-create CIU Plus compliant map.
 If ENTIS compliant modbus map is configured in TCP/IP, then delete

and recreate ENTIS compliant map.
 If Density profiles are configured as part of TCP/IP User defined

modbus maps, then set the density map to default and configure it as
required.
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 If importing from R130 then temperature spots configured as part of
TRL2 gauge will be removed and it is no more available for selection.

To get Multispot Temperature, temperature profiles has to be configured
in TRL2 gauge as follows:

a) Select the TRL2 Gauge.

b) Enable Temperature Profiles checkbox and configure the Scan
period, Slave ID, Modbus Address, Device Type and click on
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Apply. For more details refer section 3.2.10.4

c) Remove Multi Spot temperatures configured in User Defined
modbus maps and configure the Temperature parameters in
'Temperature' tab of User defined modbus map. 
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The Open window appears.

3. Select the site database file and click Open.

The files are imported to the current CIU 888 Service tool.
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3.7 Opening an existing site configuration

1. From the CIU 888 Service Tool window, Choose File > Open.

The SelectSiteForm window appears.

2. Select the required site and Click Select.
You can see the selected site details now.

NOTE: Migrating Service tool database from previous releases to the current release
(R210) is possible.
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CHAPTER 4 COMMISSIONING OF A STANDALONE SYSTEM SETUP

Perform the following steps to commission a standalone CIU 888
system setup:

1. Log on to the CIU 888 and changing the initial password, see section
4.2.1

2. Verify the CIU 888 license, see section 4.2.2
3. Configure the site using Service Tool, see section 4.3
4. Send the site configuration to the CIU 888, see section 4.4
5. Generate the INI files, see section 4.5
6. Start the Entis Pro system connected to the CIU 888, and loading the

INI files in Entis Pro, see section 
7. Verify the CIU 888 system setup is working properly, see section

4.10
8. Seal the CIU 888, see section 4.11

4.1 Requirements for commissioning

For the commissioning of a standalone CIU 888 system setup the
following requirements must be met:

 The electrical and mechanical installation of the CIU 888 must be
completed. Refer to the Installation Manual CIU 888 (Part No.
4417590) for more information.

 The CIU 888 must be switched on, see section 7.1.1
 Both the W&M lock key switch and the Configuration lock key switch

must be in ‘unlocked’ position, see section 7.2
 A PC/laptop running the CIU 888 Service Tool must be connected to

the Service port of the CIU 888 using a Cat. 5 Ethernet cable (patch
or crossover). The Service port is located at the front of the CIU 888
(see FIGURE 4-1). See Chapter 3 for more information about the
CIU 888 Service Tool. 

FIGURE  4-1 CIU 888: Service port
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4.2 Running the initial setup of the CIU 888

The first step in the procedure for the commissioning of a standalone
CIU 888 system setup is running the initial setup.

4.2.1 Logging on to the CIU 888 and changing the initial password

During the initial setup, a user has to log on to the CIU 888 and change
the initial password first.

Procedure:

1. On the PC/laptop connected to the CIU 888, launch a browser.
2. Enter the IP address of the CIU 888 in the address bar of the

browser. The IP address is: 192.168.1.1. Press the Enter key.
The Login window of the CIU 888 is displayed. 

FIGURE  4-2 CIU 888: Login window

3. Enter the username and password to log in to the CIU 888. The
username is: ciuadmin. The initial password is CIU888@Enraf.
Click LOG IN.
After entering a valid username and password, the CIU 888 prompts
to change the password of the ciuadmin account (see FIGURE 4-3). 

FIGURE  4-3 CIU 888: Change Password window

NOTE: Changing the password is only required during the initial setup of the CIU 888.
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4. Change the password of the ciuadmin account.
a) Enter the current password in the Old Password text box.
b) Enter the new password in the New Password text box and in the

Confirm Password text box.
The password must meet the following criteria:
- It must not be the same as the previous password
- It must not contain any dictionary words (for example, password)
- It must be at least eight characters long
- It must contain at least one number and one special character
- It must not contain special characters !, ’ and ” 

c) Click Apply.
The CIU 888 Web interface is displayed. By default, the
DIAGNOSTICS window is displayed. (see FIGURE 4-4).

FIGURE  4-4 CIU 888 Web interface: Diagnostics window
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4.2.2 Verifying the CIU 888 license

NOTE: When the initial password is changed, verify if a license is installed on
the CIU 888 and if it supports the functionality ordered.Refer to the
Firmware Upgrade Manual (Part No. 4417596) for more information about the
CIU 888 license.

Perform the following procedure:

1. In the CIU 888 Web interface, click CONFIGURE in the section
menu bar. 
The CONFIGURE window is displayed (see FIGURE 4-5). 

FIGURE  4-5 CIU 888 Web interface: Configure window 

2. If a license is installed on the CIU 888, ‘LICENSE_OK’ is displayed in
the License status field. If no license is installed, the field is empty. In
this case, contact Honeywell.
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3. Click View License to view the details of the license currently
installed on the CIU 888.
The View License window is displayed (see FIGURE 4-6). 

FIGURE  4-6 CIU 888 Web interface: View License window

4. Verify if the correct license is installed on the CIU 888. If not, contact
Honeywell.

4.3 Setting up the site configuration

After the initial set up of the CIU 888 is completed, set up the site
configuration using CIU 888 Service Tool. The site configuration can be
set either by:

 Creating a new site configuration, see section 3.2.

or

 Importing an existing CIU 888 site configuration, see section 3.6. 

4.3.1 Configuration procedure in CIU 888 Service Tool

Perform the following procedure to configure a site using CIU 888
Service Tool:

1. Preparation 
Before starting the creating and configuring the site, a number of
details must be known, e.g. site layout, information about field
cabling, tag names of site elements (i.e. gauges, tanks and CIUs),
tank information (tank strapping tables or tank capacity tables, roof
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details, etc.), information on types of stored product, host
communication setup (if applicable).

2. Creating the site and defining the global settings
The creation of the site allows CIU 888 Service Tool to store a
configuration set. The global settings are required for initiating the
site configuration. Once the global settings are defined, CIU 888
Service Tool creates a site database.

3. Creating and configuring the tanks
Tank strapping tables or tank capacity tables can be linked via an
external file.

4. Linking of the data inputs and tanks.

The site configuration created with Service Tool is saved in the folder 
C:\Users\Public\Documents\Honeywell\CIU 888 Service Tool 
R210.1. 

This folder also contains the following sub-folders:

 INI
This folder is reserved for Entis Pro INI files generated with
Service Tool.

 LOG
This folder is reserved for log files.

 STR
This folder is reserved for strapping table files linked to the tanks in
the site configuration.

 CUSTOM_TABLES
This folder Contains Density/CTL/Concentration tables

 SCR
 TRC

4.4 Sending the site configuration to the CIU 888

When the site configuration is set up, send the site configuration to the
CIU 888 using the CIU 888 Service Tool, see section 3.3.

4.5 Generating INI files

When the site configuration is sent to the CIU 888, generate the INI files
needed for Entis Pro.

Refer to section 3.4 for detailed information about generating INI files
using CIU 888 Service Tool.
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4.6 Starting Entis Pro and loading the updated INI files in Entis Pro

When the INI files are generated, start the Entis Pro system connected
to the CIU 888 and then load the INI files in Entis Pro. Refer to the
Configuration manual Entis Pro version 2.80x for Windows 10 

(Part No. 4416381) for more information.

4.7 Loading the CIU site database in ENTIS

Load the update CIU site database in ENTIS using ENTIS Configuration tool. In
case of multiple CIU888s in a site, load all CIU site databases in ENTIS. Refer to
the ENTIS Installation and Configuration guide (ETDOC-X613) for more
information.

4.8 OPCUA Certificate Management

OPCUA secure communications require certificate to be exchanged
and trusted between CIU888 (OPCUA server) and Inventory systems
(OPCUA clients). Certificate exchange will happen when any one sign
and sign/encrypt option is selected while configuring in CIU888 Service
tool. Default Policy is “Security Policy – Basic256Sha256 – Sign and
Encrypt”. 

None policy: Not a secure communication

Other policy: It is a secure communication with/without encryption. Sign
refers to secure communication without encryption. Sign and encrypt
refers to secure communication with encryption. Multiple policies can be
selected during configuration. When client application connects, CIU
presents all configured polices and the client application can choose
one for the connection with CIU.(see FIGURE 4-7)
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FIGURE  4-7 OPCUA Security policy and mode configuration.

CIU supports security via self-signed certificates and CA-signed
certificates. Based on the site requirements either one can be chosen
by the user. The certificate management is handled via CIU 888's web
interface.

Login to the CIU 888 Web portal and navigate to the CONFIGURE tab.
Two sections are available as OPCUA CA Signed Certifcate and
OPCUA Self Signed Certificate.(see FIGURE 4-8)

FIGURE  4-8 CIU888 Web Interface Configure tab.
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4.8.1 OPCUA Self-Signed Certificate Management

Self-signed certificate security flow involves the user trust the
certificates manually.

That is, OPC client certificate needs to be trusted in CIU 888 and CIU
888 server certificate needs to be trusted in OPC client application.
When OPCUA server is enabled, CIU creates the self-signed server
certificate (if not available) at the start up. The validity of the server
certificate is 2 years from the creation date. Generated self-signed
certificate would be of the format application_rsa_sha256_UniqueId.der
(example:application_rsa_sha256_23B922307EE1EEFF765DEE2E6E
886CD2914C82EF.der).

OPC client certificate management can be done via Manage Certificate
option (or) Upload Certificate option.

4.8.1.1 Download Server Certificate:

The user shall use this option to download the CIU 888 server self-
signed certificate. 

1. Under OPC UA Self Signed Certificate section, click "Download
Server Certitificate" option and certificate gets downloaded.

4.8.1.2 Upload Certificate:

The user can upload the client certificate to CIU through this option if it
is available. On upload, CIU adds the client certificate to the trusted
certificate store.
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1. Under OPC UA Self Signed Certificate section, click "Upload
Certitificate" option and browse to the client certificate to be
uploaded and Click Apply

2. The user would be prompted for a restart of CIU, click Yes.

NOTE: Secure communication is established between CIU and the OPC Client
application after CIU restart.

4.8.1.3 Manage Certificate:

The user manage the OPC UA client certificates through this option.
When an OPC UA client connects to CIU, the client gets the CIU’s OPC
UA server certificate. If the user trusts the CIU server certificate in the
OPC UA client application, then OPC UA client sends its certificate to
CIU. By default, the received client certificate to be added to rejected
certifcate store in CIU. The user has to manually trust the client
certificate to enable CIU communication with the OPC UA client.
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1. Under OPC UA Self Signed Certificate section, click "Manage
Certitificate" option and a list of rejected client certificates are
presented to the user.

2. Select the desired client certificate from Rejected Certificate section and
click > option. This certificate is moved to Approved Certificate section.

3. Click Apply and the user would be prompted for a restart of CIU, click Yes.

NOTE: Secure communication is established between CIU and the OPC Client
application after CIU restart.
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NOTE: In case of a redundant system, above steps have to be done separately for
CIUA and CIUB. Both certificates are different.

4.8.2 OPCUA CA-Signed Certificate Management

CA-signed certificate security flow involves the server and the client
certificates being signed by a Certificate Authority (CA). The trust is
established through the CA certificate that is used to sign the server and
client certificates. That is, the CA certificate used to sign the server
certificate needs to be added to trusted CA certificate store of the client
application and the CA certificate used to sign the client certificate
needs to be added to trusted CA certificate store of the server.

The following steps are involved in a CA-signed certificate security flow
in CIU 888:

1. Generate CSR (Certificate Signing Request) for CIU
2. Send the generated CSR to Certificate Authority for server certificate

signing. Request the following from the CA:
a) Signed CIU 888 Server certificate (.der)
b) Root CA certificate (.der)
c) Certificate Revocation List (CRL) (.crl)

3. Upload the received certificates to CIU.
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4.8.2.1 Generate CSR: 

Click on “Generate CSR” under OPCUA CA Signed Certificate. Provide
necessary information and click apply. CSR will be downloaded to PC.
Share this .csr file to CA.(see FIGURE 4-9).

FIGURE  4-9 Generate CSR - OPCUA CA signed certificate management

4.8.2.2 Upload Certificates:

Click on upload certificates under OPCUA CA Signed Certificate
section. 

 Browse CA Certificate: Browse the received root CA certificate in .der
format.

 Browse CA CRL: Browse the received root CA CRL in .crl format
 Browse Server Certificate: Browse the the received signed server

certificate (in .der format).

Name Description
Common Name Name of the server. 
Organization Name of the organization
Department Name of the Department
Locality Name of the locality
State Name of the state.

Country Country code. IN, DE, US. This should be a two
letter code.

RSA Key Size

Default: 2048.

Supports 2048 and 4096. If 4096 key size is
used, initial connection time at the client appli-
cation needs to be adjusted as it may add some
delay of 5-10 secs. 
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When prompted for a restart, click on Yes. Once the CIU restarts,
OPCUA client will communicate with the CIU888 securely over OPCUA.
(see FIGURE 4-10)

FIGURE  4-10 OPCUA CA Signed certificate.

NOTE: If different CA is used for Client application to sign: get its CA root certificate
and CA CRL of that CA and upload to CIU using “upload Certificate” under
OPCUA CA Signed Certificate. Browse CA Certificate and Browse CA CRL
only and click apply to upload the certificates. Now both CAs used for Client
and Server are uploaded to CIU888.

NOTE: In case of a redundant CIU888, workflow steps have to done separately for
CIUA and CIUB. Both certificates are different.

4.8.2.3 Download Server Certificate: 

To download the CA signed certificate created from CIU888. This is
useful after uploading the signed CIU888 certificate. 

4.8.2.4 Workflow for OPCUA client applications (CA Signed):

1. The OPCUA Client application will also have a provision to generate
CSR.

2. Send the generated CSR to CA and get three certificates back from
CA.
a) Signed Client application certificate in format as application

requires.
b) Root CA certificate in format as application requires.
c) Root certificate revocation list (.crl).

3. Upload the received certificates to client application.

NOTE: If different CA is used for CIU888 to sign: get its CA root certificate and CA
CRL of that CA and add to respective directory of client application certificate
management. Now Both CA root certificate and CA root CRL will be present.
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Following are the directory structure of UA expert.

Eg:C:\Users\<username>\AppData\Roaming\unifiedautomation\uaexpe
rt\PKI\issuers\certs

Eg:C:\Users\<username>\AppData\Roaming\unifiedautomation\uaexpe
rt\PKI\issuers\crl

4.9 Self Signed Certificate Management with ENTIS

ENTIS automatically generates a self-signed certificate to communicate
with the CIU 888. To successfully establish secure communication with
the CIU 888, the ENTIS self-signed certificate and the CIU 888 server
certificate need to be trusted by each other. This can be done with the
following steps: 

1. Trusting server certificate, move the certificate from

C:\ProgramData\Honeywell\Entis\Communication\OPCUA\Certificates\
EntisOPCUAClient\pki\rejected\certs

to

C:\ProgramData\Honeywell\Entis\Communication\OPCUA\Certificates\
EntisOPCUAClient\pki\trusted\certs

2. Trusting client certificate.
a) Login to the CIU 888 Web portal and navigate to the 

CONFIGURE tab.(see FIGURE 4-11)
b) Click on Manage Certificates under the OPC UA Self Signed

Certificates header. The ENTIS self-signed certificate can be
seen in the Rejected Certificate section.

FIGURE  4-11 CIU888 Web Interface: Configure tab
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FIGURE  4-12 Mange certificate: OPCUA CA Signed certificate.

c) Select the certificate and move it to the Approved Certificate
section.(see FIGURE 4-13)

FIGURE  4-13 Mange certificate: OPCUA CA Signed certificate.

d) Click on Close and when prompted for a restart, click on
Yes.Once the CIU restarts, ENTIS will communicate with the CIU
securely over OPC.

NOTE: The ENTIS client certificate is valid for a period of 1 year after which a new
certificate will be generated. The new certificate must be approved in a similar
way.

NOTE: If steps a, b, and c are redundant, they must be performed on both CIUA and
CIUB.

4.10 Verifying the working of the system setup

The last step in the commissioning procedure is verifying if the CIU 888
system setup is working properly.
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To verify the working of the system setup, the CIU 888 must be
connected to:

 PC/laptop running the CIU 888 Service Tool via Service port located
at the front using a Cat. 5 Ethernet cable 

 PC/laptop running the Modbus Host (e.g. Entis Pro) via one of the
configured serial host ports using RS-232/RS-485 cable (see
FIGURE 4-14)

FIGURE  4-14 CIU 888: Serial host ports

 PC/laptop running the Modbus TCP/IP Host and / or OPC UA TCP
Host via one of the configured ethernet host ports using network
cable (see FIGURE 4-15)

FIGURE  4-15 CIU 888: FTE A, FTE B and LAN ports
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Perform the following procedure:

1. Launch the CIU 888 Web interface. See section 3.1.4 for more
information.

2. Verify the CIU 888 configuration options in the Web interface.
3. Logout of the Web interface.
4. Verify the CIU 888 functioning by checking the received values on

the Modbus Host and / or OPC UA TCP Host. 

4.11 Sealing the CIU 888

If the CIU 888 sealing option is licensed, the next step is to have it
sealed by a representative of the LM authorities or by a LM accredited
user. Refer to the CIU 888 Sealing Guide (Part No. 4417595) for more
information.

NOTE: If the CIU 888 does not feature the option to be sealed, the W&M lock key
switch and the configuration lock key switch can either be locked or left
unlocked.
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CHAPTER 5 COMMISSIONING OF A REDUNDANT SYSTEM SETUP 

Redundancy is a common approach to improve the reliability and
availability of a system. In a redundant CIU 888 system setup, one
CIU 888 (usually the primary CIU 888) has the active role and its
counterpart (usually the secondary CIU 888) has the passive role.
During normal operation, the CIU 888 that has the active role scans the
connected gauges for data and provides the measured and calculated
data to host systems.

If both CIU 888s in a redundant system setup are fully synchronized
and the connected host initiates a switchover, the CIU 888 that has the
active role assumes the passive role. The CIU 888 that has the passive
role assumes the active role and continues to perform the tasks that are
performed by the CIU 888 that previously had the active role.

Switchover command issued by Entis Pro via Modbus serial is one such
example.

NOTE: Refer to the Protocol Manual - Modbus and OPC UA Host (Part No. 4417588)
for more information about setting up of Modbus host for redundancy.

NOTE: The active CIU 888 can either be the primary CIU 888 or the secondary
CIU 888.

The redundancy status of the CIU 888 (active or passive) is presented
through the following (host) systems:

 Entis Pro (via Modbus RTU)
 ENTIS (via OPC UA TCP)
 Other Modbus RTU host systems
 Other Modbus TCP/IP host systems
 Other OPC UA TCP host systems

Perform the following procedure to commission a redundant CIU 888
system setup:

1. Log on to the CIU 888 and changing the initial password, see
section 5.2

2. Verify the CIU 888 license, see section 5.2
3. Configure the site using Service Tool, see section 5.3
4. Send the site configuration to the primary CIU 888, see section 5.4
5. Commission the secondary CIU 888, see section 5.5
6. Generate the INI files, see section 5.6 and Start the Entis Pro system

connected to the CIU 888, and load the INI files in Entis Pro, see
section 5.8

7. Verify the working of the system setup, see section
8. Seal the CIU 888s, see section 5.13
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5.1 Requirements for commissioning

For commissioning of a redundant CIU 888 system setup, the following
requirements must be met:

 The mechanical and electrical installation of both the primary
CIU 888 and the secondary CIU 888 must be completed. Refer to
the CIU 888 Installation Manual (Part No. 4417590) for more
information.

 Both the primary CIU 888 and the secondary CIU 888 must be
switched on. See section 7.1.1 for more information.

 The W&M lock key switch and the Configuration lock key switch of
both the primary CIU 888 and the secondary CIU 888 must be in
‘unlocked’ position. See section 7.2 for more information.

 The primary CIU 888 and the secondary CIU 888 must be linked
through their Sync Link ports using a Cat. 5 Ethernet cable (patch or
crossover). The Sync Link port is located at the back of the CIU 888
(see FIGURE 5-1). 

FIGURE  5-1 CIU 888: Sync Link port

 A PC/laptop running the CIU 888 Configuration System must be
connected to the Service port of the primary CIU 888 using a Cat. 5
Ethernet cable (patch or crossover). The Service port is located at
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the front of the CIU 888 (see FIGURE 5-2). See CHAPTER 3 for
more information about the CIU 888 Configuration System. 

FIGURE  5-2 CIU 888: Service port

 During commissioning of the CIU 888s, the Entis Pro system(s)
connected to the CIU 888s must be shut down. 

5.2 Running the initial setup of the primary CIU 888

The first step in the procedure for the commissioning of a redundant
CIU 888 system setup is performing the initial setup procedure of the
primary CIU 888. See section 4.2 for more information.

5.3 Setting up the site configuration

When the initial setup of the primary CIU 888 is completed, then set up
the site configuration using CIU 888 Service Tool. The site configuration
can be set up either by:

 Creating a new site configuration, see section 3.2.

or

 Importing an existing CIU 888 site configuration, see section 3.6.

5.4 Sending the site configuration to the primary CIU 888

When the site configuration is set up, send the site configuration to the
primary CIU 888 using the CIU 888 Service Tool. See section 3.3 for
more information.

5.5 Commissioning of the secondary CIU 888

When the primary CIU 888 is commissioned, then configure its
counterpart as preferred secondary CIU 888.
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Perform the following procedure:

1. On the display of the secondary CIU 888, highlight the
Configuration icon in the Status Dashboard using the navigation
keys. Next, press the OK button.
The Configuration menu screen is displayed (see FIGURE 5-3). 

FIGURE  5-3 CIU 888 display: Configuration menu screen

2. Highlight the required Redundancy option using the navigation
keys. Click the OK button.
The Redundancy screen is displayed (see FIGURE 5-4). 

FIGURE  5-4 CIU 888 display: Redundancy screen
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3. Highlight the Preferred secondary option using the navigation keys
and then press the OK key.
The Confirm Changes screen is displayed. 

FIGURE  5-5 CIU 888 display: Confirm Changes screen

4. Highlight the OK option using the display keys. Click OK key.
The secondary CIU 888 is reset to the factory settings and reboots
twice. Because the Entis Pro system(s) connected to the CIU 888s is
shutdown, redundancy switchover is disabled during reboot. 

5. Connect the PC/Laptop to the secondary CIU 888. Log on to the
secondary CIU 888 and change the initial password, refer to
section 4.2.1.

6. Verify the CIU 888 license, refer to section 4.2.2.

When commissioning of both the primary CIU 888 and secondary
CIU 888 is completed, the role of each CIU 888 in the redundant
system setup is indicated in the Status Dashboard (see FIGURE 5-
6). 

FIGURE  5-6 Status Dashboard of primary CIU 888 (left) and secondary CIU 888 (right)
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5.6 Generating INI files

When the site configuration is sent to primary CIU 888, then generate
the INI files required for Entis Pro.

Refer to the section 3.4 for detailed information about generating INI
files using CIU 888 Service Tool.

5.7 Loading the CIU site database in ENTIS

Load the update CIU site database in ENTIS using ENTIS Configuration
tool. In case of multiple CIU888s in a site, load all CIU site databases in
ENTIS. Refer to the ENTIS Installation and Configuration guide
(ETDOC-X613) for more information.

5.8 Starting Entis Pro and loading the INI files in Entis Pro

When the INI files are updated, then start the Entis Pro system(s)
connected to the CIU 888s and then load the INI files in Entis Pro. Refer
to the Configuration manual Entis Pro version 2.80x for Windows 10
(Part No. 4416381) for more information.

5.9 OPCUA Certificate Management.

Refer section 4.8 for details.

5.10 Self Signed Certificate Management with ENTIS.

Refer section 4.9 for details.

5.11 Procedure for communication between ENTIS and CIU 888

ENTIS automatically generates a self-signed certificate to communicate
with the CIU 888. To successfully establish secure communication with
the CIU 888, the ENTIS self-signed certificate and the CIU 888 server
certificate need to be trusted by each other. This can be done with the
following steps: 

1. Trusting server certificate, move the certificate from

C:\ProgramFiles(x86)\Honeywell\Entis\Communication\OPCUA\Certific
ates\EntisOPCUAClient\pki\rejected\certs

to

C:\ProgramFiles
(x86)\Honeywell\Entis\Communication\OPCUA\Certificates\EntisOPCU
AClient\pki\trusted\certs

2. Trusting client certificate.
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a) Login to the CIU 888 Web portal and navigate to the 
CONFIGURE tab.

b) Click on Manage Certificates under the OPC UA Self Signed
Certificates header. The ENTIS self-signed certificate can be
seen in the Rejected Certificate section.

c) Select the certificate and move it to the Approved Certificate
section.
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d) Click on Close and when prompted for a restart, click on
Yes.Once the CIU restarts, ENTIS will communicate with the CIU
securely over OPC.

NOTE: The ENTIS client certificate is valid for a period of 1 year after which a new
certificate will be generated. The new certificate must be approved in a similar
way.

5.12 Verifying the working of the system setup

The final step in the commissioning procedure is verifying if the
redundant CIU 888 system setup is working properly. See section 4.10
for more information.

5.13 Sealing the CIU 888s

If the CIU 888s sealing option is licensed, the next step is to have them
sealed by a representative of the LM authorities or by a LM accredited
user. Refer to the CIU 888 Sealing Guide (Part No. 4417595) for more
information.

NOTE: If the CIU 888s do not feature the option to be sealed, the W&M lock key
switches and configuration lock key switches can either be locked or left
unlocked.
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CHAPTER 6 UPDATING CIU 888 SITE CONFIGURATION 

If there are changes in the CIU 888 system setup, these changes must
be implemented in the site configuration. Subsequently, the updated
site configuration must be sent to the CIU 888 for the changes to
become effective.

Changes in the CIU 888 system setup can be the result of the following.
For example:

 Connection of additional tank gauging instruments to the CIU 888
 Connection of additional host systems to the CIU 888
 Installation of a new CIU 888 license resulting in the expansion of the

features and functionalities of the CIU 888 (e.g. redundancy, support
of a larger number of tanks)

Perform the following steps to update the CIU 888 site configuration:

1. Implement the required changes in the site configuration, see
section 6.3

2. Send the updated site configuration to the CIU 888, see section 6.4
3. Generate the INI files required for Entis Pro, see section 6.5
4. Start the Entis Pro system connected to the CIU 888, and load the

INI files in Entis Pro, see section 6.6
5. Verify the working of the system setup, see section 6.7
6. Seal the CIU 888, see section 6.8

6.1 Requirements for updating the non redundant CIU 888 site config-
uration

The following requirements must be met in order to update the CIU 888
site configuration: 

 The CIU 888 must be switched on. See section 7.1.1 for more
information.

 For LM relevant parameters update, W&M lock key switch and
Configuration lock key switch of the CIU 888 must be in 'unlocked'
position. See section 7.2 for more information.

 For non LM parameters update, Configuration lock key switch of the
CIU 888 must be in 'unlocked' position. See section 7.2 for more
information.

 A PC/laptop running the CIU 888 Configuration System must be
connected to the Service port or VPN port of the CIU 888 using a
Cat. 5 Ethernet cable (patch or crossover). The Service port is
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located at the front of the CIU 888 (see FIGURE 6-1). See Chapter 3
for more information about the CIU 888 Configuration System. 

FIGURE  6-1 CIU 888: Service port

6.2 Requirements for updating the redundant CIU 888 site configura-
tion

The following requirements must be met in order to update the CIU 888
site configuration: 

 The primary CIU 888 and the secondary CIU 888 must be in sync.
 For LM parameters update, W&M lock key switch and Configuration

lock key switch of Primary CIU 888 and Secondary CIU 888 must be
in 'unlocked' position. See section 7.2 for more information.

 For non LM parameters update, Configuration lock key switch of
Primary CIU 888 and Secondary CIU 888 must be in 'unlocked'
position. See section 7.2 for more information.

 A PC/laptop running the CIU 888 Configuration System must be
connected to the Service port of the CIU 888 using a Cat. 5 Ethernet
cable (patch or crossover). The Service port is located at the front of
the CIU 888 (see FIGURE 6-1). See Chapter 3 for more information
about the CIU 888 Configuration System.

6.3 Implementing the required changes in the site configuration

Perform the following procedure to implement the required changes in
the site configuration:

1. Launch CIU 888 Service Tool (refer to section 3.2.2).
2. Load the applicable CIU 888 site configuration (refer to section 3.7).
3. Navigate through the CIU site nodes and do the required changes. If

any new site nodes are required, create and configure them (refer to
section 3.2.5, section 3.2.6, section 3.2.7, section 3.2.9, and
section 3.2.11).
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6.4 Sending the site configuration to the CIU 888

When the site configuration is set up, send the site configuration to the
CIU 888 using the CIU 888 Service Tool, see section 3.3.

NOTE: In case of updating redundant CIU 888, the configuration should be sent to
Primary CIU 888.

6.5 Generating the INI files

When the site configuration is sent to CIU 888, the next step is to
generate the INI files needed for Entis Pro. Refer to section 3.4 for
detailed information about generating INI files using Service Tool.

6.6 Starting Entis Pro and reloading INI files in Entis Pro

When the INI files have been generated, then start the Entis Pro system
connected to the CIU 888 and then load the INI files in Entis Pro. Refer
to the Configuration manual Entis Pro version 2.80x for Windows 10
(Part No. 4416381) for more information.

6.6.1 Using Entis as a host

To use Entis as a host, refer to the Entis Manuals in Honeywell Entis 
HUB accessible from https://process.honeywell.com/us/en/products/
terminals/enraf-tank-gauging/entis-tank-inventory-system

6.7 Verifying the working of the CIU 888 system setup

The final step in the procedure for updating the CIU 888 system setup is
verifying if the system setup is working properly. See section 4.10 for
more information.

6.8 Sealing the CIU 888

If the CIU 888 features the option to be sealed, the next step is to have
it sealed by a representative of the LM authorities or by a LM accredited
user. Refer to the CIU 888 Sealing Guide (Part No. 4417595) for more
information.

NOTE: If the CIU 888 does not feature the option to be sealed, the W&M lock key
switch can either be locked or left unlocked.
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6.9 Special Operating Procedure to perform configuration updates on 
redundant CIU

CIU 888 has a private sync link between the Primary CIU and
Secondary CIU through which the data gets synchronized. During
configuration updates, the configuration is updated to Primary (Active)
CIU and the configuration updates gets synchronized to Secondary
(Passive) CIU through the private sync link. This is the recommended
procedure for most of the customers as CIU 888 takes care of the
configuration synchronization automatically and ensures both Primary
CIU and Secondary CIU has the same configuration.

For certain customers, the need is slightly different. These customers
want to perform the configuration updates to one CIU (Secondary CIU)
in the redundant pair, test the configuration changes and if the
configuration changes are working fine then update the configuration
changes to the partner CIU. The following operating procedure needs to
be followed to achieve this behavior. “CIU A” refers to the Active CIU
and “CIU B” refers to the Passive CIU.

6.9.1 Updating configuration for Restart parameters

This section covers the configuration update procedure that involves
restart of CIU 888.

1. Login to CIU A webpage and disable configuration synchronization.
Proceed to the next step on seeing "configuration sync is disabled
successfully" message.

2. Make configuration changes in service tool/Ensite Pro tool.
3. Update configuration to CIU B by connecting via service/VPN port. 

NOTE: CIU B will restart and will take up Passive role with 1-99 in hot stand by
window.
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NOTE: Generate INI files from CIU B by connecting via service/VPN port.

If Entis Pro is the host then reload INI files. If Entis is used as host then reload
the site DB in Entis.

NOTE: a) Entis pro automatically issues switch over if CIU B had taken value 1-99 in
hot standby window on step 3. After switch over, CIU A will take value as 1-99
and role as Passive and CIU B will take value 100 and role as Active.
b) If both the CIUs (A and B) have value as 100, then user has to make CIU B
as Active by issuing a switch over command.

4. If configuration change is working as intended, skip to step 7.
5. Configuration change is not working as intended.

If the Host is Entis Pro then connect to CIU A via service/VPN port
and generate and reload INI files. 
If the Host is ENTIS then reload the site DB in Entis.

NOTE: a) Entis pro automatically issues switch over if CIU A had taken value 1-99 in
hot standby window on step 5. Now CIU A will become active and take value as
100 and CIU B will become passive and take value as 1-99. 
b) If both the CIUs (A and B) have value as 100, then user has to make CIU A
as Active by issuing a switch over command.

6. Make configuration changes in Service Tool/Ensite Pro revert the
configuration. Go to step 3.

7. Configuration update works as intended. Login to Active CIU (CIU B)
web interface and enable configuration sync. This will restart the
partner CIU A 

NOTE: CIU A will restart and take up Passive role with Hot standby value 100. 

8. Issue a switch over in Entis Pro. CIU A takes up Active role and CIU
B will take up Passive role.
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6.9.2 Updating configuration for Non-Restart parameters

This section covers the configuration update procedure that does not
involve restart of CIU 888.

1. Login to CIU A webpage and disable configuration synchronization.
Proceed to the next step on seeing "configuration sync is disabled
successfully" message.

2. Make configuration changes in service tool/Ensite Pro tool.
3. Update configuration to CIU B by connecting via service/VPN port. 

NOTE: CIU B remains Passive with value 100 or 1-99 in hot stand by window.

NOTE: Generate INI files from passive CIU B by connecting via service/VPN port.

If Entis Pro is the host then reload INI files. If Entis is used as host then reload
the site DB in Entis.

NOTE: a) Entis pro automatically issues switch over if CIU B had taken value 1-99 in
hot standby window on step 3. After switch over, CIU A will take value as 1-99
and role as Passive and CIU B will take value 100 and role as Active.
b) If both the CIUs (A and B) have value as 100, then user has to make CIU B
as Active by issuing a switch over command.

4. If configuration change is working as intended, skip to step 7.
5. Configuration change is not working as intended.

If the Host is Entis Pro then connect to CIU A via service/VPN port
and generate and reload INI files. 
If the Host is ENTIS then reload the site DB in Entis.
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NOTE: a) Entis pro automatically issues switch over if CIU A had taken value 1-99 in
hot standby window on step 5. Now CIU A will become active and take value as
100 and CIU B will become passive and take value as 1-99
b) If both the CIUs (A and B) have value as 100, then user has to make CIU A
as Active by issuing a switch over command.

6. Make configuration changes in Service Tool/Ensite Pro revert the
configuration. Go to step 3.

7. Configuration update works as intended. Login to Active CIU (CIU B)
web interface and enable configuration sync. This will restart the
partner CIU A

NOTE: CIU A will restart and take up Passive role with Hot standby value 100

8. Issue a switch over in Entis Pro. CIU A takes up Active role and CIU
B will take up Passive role.

This page is intentionally left blank
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CHAPTER 7 GENERAL CIU 888 FUNCTIONS

7.1 (Re)starting and shutting down the CIU 888

7.1.1 Starting the CIU 888

When the CIU 888 is connected to the mains, you can start the CIU 888
using the on/off switch at the back of the device (see FIGURE 7-1). 

FIGURE  7-1 CIU 888: on/off switch

During startup, the CIU 888 Loading... splash screen is shown on the
CIU 888 display (see FIGURE 7-2). 

FIGURE  7-2 CIU 888 display: CIU 888 Loading... splash screen

NOTE: If the CIU 888 is built into a storage cabinet, the on/off switch should be in the
‘ON’ position as it is no longer accessible. In this case, you can start the
CIU 888 by switching on the mains.
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7.1.2 Restarting the CIU 888

You can restart the CIU 888 via the CIU 888 Web interface. To restart
the CIU 888, select Restart CIU from the CIU 888 menu (see FIGURE
7-3). 

FIGURE  7-3 CIU 888 Web interface: Restart CIU option in CIU 888 menu

During restart, the CIU 888 Restarting... splash screen is shown on the
CIU 888 display (see FIGURE 7-4). 

FIGURE  7-4 CIU 888 display: CIU 888 Restarting... splash screen
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7.1.3 Shutting down the CIU 888 

Shutting down the CIU 888 is necessary if, maintenance must be
performed on the CIU 888 or if the CIU 888 must be replaced. You can
shut down the CIU 888 via the CIU 888 Web interface. To shut down the
CIU 888, select Shutdown CIU from the CIU 888 menu (see FIGURE
7-5). 

FIGURE  7-5 CIU 888 Web interface: Shutdown CIU option in CIU 888 menu

NOTE: To switch the CIU 888 back, use the on/off switch at the back of the device, see
section 7.1.1. Because the on/off switch is still in the ‘ON’ position, the on/off
switch must be switched to the ‘OFF’ position first. Subsequently, the CIU 888
can be started by switching the on/off switch to the ‘ON’ position.
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7.2 W&M lock key switch and Configuration lock key switch

The CIU 888 features two key switches located at the front of the
device:

 W&M lock key switch, see section 7.2.1.
 Configuration lock key switch, see section 7.2.2.

7.2.1 W&M lock key switch

The W&M lock key switch is used for locking and unlocking the LM
relevant configuration settings of the CIU 888. The key switch is located
at the front of the CIU 888, and is fitted with a cover (see FIGURE 7-6). 

FIGURE  7-6 CIU 888: W&M lock key switch

7.2.1.1 Unlocking the W&M relevant configuration settings

Perform the following steps to unlock the LM relevant configuration
settings of the CIU 888:

1. If the cover of the W&M lock key switch is sealed, remove the
hardware seal (wire) in order to get access to the key switch.

2. Take the key for locking/unlocking the W&M relevant configuration
settings and insert it in the key switch. Then, turn the key counter-
clockwise.
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On the CIU 888 display, the status of the W&M lock key switch
changes from  (‘locked’) to  (‘unlocked’) (see FIGURE 7-7). 

FIGURE  7-7 CIU 888 display: W&M relevant configuration settings are unlocked

3. Remove the key from the key switch and store it.

7.2.1.2 Locking the LM relevant configuration settings

Perform the following steps to lock the W&M relevant configuration
settings of the CIU 888:

1. Take the key for locking/unlocking the W&M relevant configuration
settings.

2. Insert the key in the W&M lock key switch. Then, turn the key
clockwise.
On the CIU 888 display, the status of the W&M lock key switch
changes from  (‘unlocked’) to  (‘locked’) (see FIGURE 7-8). 

FIGURE  7-8 CIU 888 display: W&M relevant configuration settings are locked
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3. Remove the key from the key switch and store it.

7.2.2 Configuration lock key switch 

The Configuration lock key switch is used for locking and unlocking the
configuration settings (non-LM relevant and LM relevant) of the
CIU 888. The key switch is located at the front of the CIU 888 (see
FIGURE 7-9). 

FIGURE  7-9 CIU 888: Configuration lock key switch

7.2.2.1 Unlocking the configuration settings

Perform the following steps to unlock the configuration settings of the
CIU 888:

1. Take the key for locking/unlocking the configuration settings.
2. Insert the key in the Configuration lock key switch, and then turn the

key counterclockwise.
On the Status Dashboard, the status of the Configuration lock key
switch changes from  (‘locked’) to  (‘unlocked’) (see FIGURE
7-10).

FIGURE  7-10 Status Dashboard: configuration settings are unlocked
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3. Remove the key from the key switch and store it.

7.2.2.2 Locking the configuration settings

Perform the following steps to lock the configuration settings of the
CIU 888:

1. Take the key for locking/unlocking the configuration settings.
2. Insert the key in the Configuration lock key switch, and then turn the

key clockwise.
On the Status Dashboard, the status of the Configuration lock key
switch changes from  (‘unlocked’) to  (‘locked’) (see FIGURE
7-11). 

FIGURE  7-11 Status Dashboard: configuration settings are locked

3. Remove the key from the key switch and store it.
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APPENDIX A DATA HANDLING

A.1 Engineering units

System engineering units are required for proper rounding of the
internal engineering units. The system engineering units are selected
during the configuration of the CIU 888, and also in a later stadium
when the settings of the CIU 888 are configured (partly or fully) and the
CIU 888 is operational. The CIU 888 Web interface presents the
configuration settings in the selected system engineering units.

The CIU 888 supports the same set of engineering units as supported
by the Service Tool.

A.2 Data presentation

A.2.1 Decimal and thousand separators

A.2.1.1 Decimal separator

The CIU 888 displays its floating point numeric data with a decimal
separator which is either a dot (default) or a comma. Other characters
are not allowed. A number cannot start nor end with a decimal
separator. For example, ‘0.2’ is correct, but ‘.2’ is not correct.

NOTE: The decimal separator parameter is under the W&M seal.

A.2.1.2 Thousand separator

The CIU 888 displays its numeric data with a thousand separator which
is either a dot, a comma (default) or no separator (space). Other
characters are not allowed. The thousand separator is applied before
and after the decimal separator to group three digits. A number cannot
start nor end with a thousand separator.

NOTE: The thousand separator parameter falls under the W&M seal.

A.2.1.3 Configuring the decimal separator and thousand separator

The decimal separator and thousand separator are both initialized
during setup of the site configuration in Service Tool, and are taken from
the settings configured for the PC/laptop running Service Tool.

To configure the decimal separator and thousand separator:
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1. On the PC/laptop running Service Tool, go to  (Start) > Control
Panel.
The Control Panel is displayed (see FIGURE A-1). 

FIGURE  A-1 Control Panel
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2. Click Clock, Language, and Region.
The Clock, Language, and Region window is displayed (see
FIGURE A-2). 

FIGURE  A-2 Control Panel: Clock, Language, and Region window
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3. Click Region and Language. 
The Region and Language window is displayed. By default, the
Formats tab is displayed (see FIGURE A-3). 

FIGURE  A-3 Region and Language window
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4. Click Additional settings.... 
The Customize Format window is displayed (see FIGURE A-4). 

FIGURE  A-4 Customize Format window

5. From the list box next to ‘Decimal symbol:’ select the symbol to be
used as decimal separator.

6. From the list box next to ‘Digit grouping symbol:’ select the symbol to
be used as thousand separator.

7. Click OK to save the settings and to close the window.

A.2.2 Time stamped data

Measured and calculated data is accompanied with a time stamp with
the same resolution as the time stamp configured in the CIU 880.

See section A.2.3 for more information about time resolutions.

A.2.3 Date and time presentation

A.2.3.1 Date

Dates are always presented in ISO format, i.e. YYYY-MM-DD, where:

 YYYY = the year (all digits)
 MM = the month (01 (January) to 12 (December))
 DD = the day (01 to 31)
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For example, ‘3rd October 2013’ is presented as 2013-10-03. 

A.2.3.2 Time

Times are presented in one of the following formats:

 Times in minutes resolution are presented as hh:mm
 Times in seconds resolution are presented as hh:mm:ss
 Times in milliseconds resolution are presented as hh:mm:ss.ttt

where:
 hh = zero-padded hour between 00 and 24
 mm = zero-padded minute between 00 and 59
 ss = zero-padded second between 00 and 60
 ttt = zero-padded between 000 and 999

NOTE: The AM/PM part of time should not be at the start. So time format AM 03:55 is
not allowed. Only the standard windows time formats are supported.

A.3 List of entities not needing restart after a change
TABLE  A-1 List of CIU 888 entities that do not require a restart after changing

Entity Name Entity Number
VolumeCorrections 24

ProductTRef 26

ProductDref 30

ProductDrefStatus 31

SedAndWater 32

ProductTC 33

ProductTCStatus 34

LiqVolRatio 35

ProductLevel 40

ProductLevelStatus 41

WaterLevel 42

WaterLevelStatus 43

ProductTemp 44

ProductTempStatus 45

VapRoomTemp 46

VapRoomTempStatus 47

VapRoomPressure 48
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VapRoomPressureStatus 49

Dobs 50

DobsStatus 51

WaterVol 56

WaterVolStatus 57

MolarWeight 79

TankTRef 90

ThermalexpCoeffTankshell 91

TankAirDensity 92

AmbientTemperature 103

AmbientTemperatureStatus 104

InsulationFactor 109

LowestTemperatureElement 110

Tobs 118

TobsStatus 119

CTL (VCF) 124

CTLStatus 125

TCF 126

TCFStatus 127

DCF 128

DCFStatus 129

TankTypeStatus 133

ShellCapacityStatus 134

LowTOVStatus 135

HighTOVStatus 136

GSVCalcTypeStatus 138

ProductCodeStatus 139

VolumeCorrectionsStatus 140

ProductTRefStatus 142

SedAndWaterStatus 143

LiqVolRatioStatus 144

MolarWeightStatus 145

TankTRefStatus 155

TankTCStatus 156

AirDensityStatus 157

InsulationFactorStatus 158

Entity Name Entity Number
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WaterDipOffset 2070

NegativeLevelsEnabled 2073

Moving TripValue 2100

MovingIntervalTime 2101

StandardAmbientAirPressure 3026

TankPressureOrientation 3028

GaugeAlarmHandling 3045

IPConfigurationCRC 3508

IPDipswitchStatus 3511

TankZoneControl 4003

TankZoneStart 4004

TankZoneEnd 4005

TankZoneCorrection 4006

FloMul 5042

FloIntervalTime 5043

GaugeDetail 6500

GSVCalcType 8122

ProductCode 8123

AlphaType 2155

SampleDensityStatus 9133

SampleTemperatureStatus 9135

ProductConfigurationCRC 9160

Entity Name Entity Number
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APPENDIX B SCANNING

The main task of the CIU 888 is scanning the connected tank gauging
instruments continuously for the measured values of the connected
devices.

B.4 Scanning Philosophy

CIU 888 incorporates time-based scanning for better scanning
performance. CIU 888 maintains a scan items pool per field port /
sequenced field ports that has the list of scan items to be scanned.
Each scan item is allocated a minimum scan period and a maximum
scan period. Minimum scan period is the minimum expected time
interval at which the scan item must be scheduled in milliseconds and
maximum scan period is maximum time interval within which the scan
item must be scheduled in milliseconds.

Based on the scan periods and current scanning pattern of the scan
items, CIU 888's scanning algorithm picks up the most useful item
among all the scan items configured for a field port and sends it to the
field. In case of sequenced field ports (channel sequencing), CIU 888's
scanning algorithm picks up the most useful item among all the scan
items configured for the field ports that are sequenced.

Following are the various scan items processed by CIU 888.

B.5 Configured Foreground scan items

The CIU 888 scans measurable data inputs (for example, product level)
that are configured in the foreground scan more often than data inputs
configured in the background scan.

In tank gauging, the most important data to retrieve from gauging
instruments on a tank is the level. The core competency of the scanner
is to update each value on a regular basis. If tank calculation is part of
the solution, a change of each new level value triggers the calculations
module to recalculate the tank record.

B.6 Configured Background scan items

Measured data inputs that do not change frequently, for example the
average temperature of a tank, do not need to be scanned with the
same scan rate as the values that are scanned in the foreground scan.

The CIU 888 scans all measurable data inputs that are configured in the
foreground with a higher priority ((i.e) less minimum and maximum scan
period) than the measurable data inputs that are configured in the
background scan.
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B.7 Command scan items

When gauge commands are issued from the Host system, gauge
command scan items are added to the scan items pool. Gauge
commands scan items are scheduled with a higher priority ((i.e) less
minimum and maximum scan period) than configured foreground and
background items.

B.8 Service Messages

When service messages are issued from Service tools like Engauge,
Winsetup service messages are added to the scan items pool. Service
messages are scheduled with a higher priority ((i.e) less minimum and
maximum scan period) than configured foreground and background
items.

Adaptive scanning based on field device communication failures:

8. Field device retries are made smarter and spread rather than
configured consecutive retries. 

9. If the communication errors are received for the configured number
of retries for a field device, the priority of all the scan items for that
field device will be reduced and retries are skipped until a valid
response is received for that field device. 

10. On receiving a valid response from the field, the priority of the field
device is moved to the appropriate level and retry mechanism is
restored. 

B.9 Priority Agent

CIU 888 also incorporates a Priority Agent which monitors the product
movement and product level close to Tank High limit and relatively
prioritizes the scan items by modifying the minimum and maximum scan
periods of the scan items so that critical parameters are scanned at a
faster rate compared to the less critical parameters. Priority agent can
be enabled / disabled with a configuration option.

Priority Agent is disabled - CIU 888 scans the field using a static time
based scanning algorithm for foreground and background scan items.
No priority changes happen based on Product movement and Tank
High Monitoring Limit.

Priority Agent is enabled - CIU 888 scans the field using a dynamic time
scanning algorithm based on the Product movement and Tank High
monitoring limit. Scan item's priority changes happen based on Product
movement and Tank High Monitoring Limit. That is, a relative
prioritization is done between static tanks (tanks with no product
movement), dynamic tanks (tanks with product movement), dynamic
tanks in which product level is beyond the configured Tank high
monitoring limit.
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The following table provides various priority levels incorporated in CIU
888.

Priority Scenario
Very High Product level when it is close to Tank high limit (beyond the 

configured Tank high monitoring limit) and product movement is 
detected.

High Service messages received over Service Ethernet port
Command scan messages.

Above Normal Product level when detected to be moving in a specific 
direction.
Product level when it is close to Tank high limit and no product 
movement is detected
Product level when it is close to Tank high limit, and device 
communication errors occur irrespective of product movement 
being detected / not.

Normal Foreground parameters (for example, Level) of static tanks i.e. 
no product movement is detected.
Product level of tanks where it was moving when device 
communication errors occur, Service / emulation messages 
received over serial host ports.

Below Normal Background parameters (for example, Temperature, Density)
Foreground parameters (for example, Level) of static tanks 
when device communication errors occur.

Low Background parameters of tanks when device communication 
errors occur.
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APPENDIX C REDUNDANCY

C.10 Sync Link and database synchronization

Redundancy between a pair of CIU 888s is realized by synchronizing
the databases of the CIU 888s. Real-time and continuous
synchronization ensures that all recently measured data is available to
both CIU 888s and is required to minimize switch-over time.

To achieve real-time and continuous synchronization, a dedicated
Ethernet connection between the pair of CIU 888s must be established,
called the Sync Link. The Sync Link connection is also used to
determine the actual role of each CIU 888 (active or passive). To
establish the Sync Link connection, the CIU 888s have to be connected
by means of a Cat. 5. Ethernet cable.

In a redundant CIU 888 system setup, the following data stores are kept
synchronized:

 Real-time data
 Active gauge commands, including status
 Configuration data
 Operational data (manual overwrites and gauge commands)
 Clock

NOTE: A failure in the Sync Link connection will disable a synchronization.

The Sync Link port is located at the back of the CIU 888 (see
FIGURE C-5). 

FIGURE  C-5 CIU 888: Sync Link port 
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C.11 Supported redundant CIU 888 topologies of deployment

The following redundant CIU 888 topologies of deployment are
supported:

 RS-232 host port redundancy with redundant CIU 888s and host port
redundancy on demand of host system (see C.11.1)

 RS-232 host port redundancy with redundant CIU 888s and data
synchronization by host system (see C.11.2)

 Modbus TCP host port redundancy with redundant CIU 888s and
data synchronization between host systems

 OPC UA TCP host port redundancy with redundant CIUs 

C.11.1 RS-232 host port redundancy with redundant CIU 888s and host port 
redundancy on demand of host system

In this configuration, both CIU 888s in the redundant configuration are
connected to the same host system, for example, Entis Pro (see
FIGURE C-6). The CIU 888s are connected to the host system via one
of their fixed host ports. Each host port has its own unique RTU address
and is configured for communication through Modbus RTU on serial. 

FIGURE  C-6 RS-232 Host port redundancy with redundant CIU 888s and host port redundancy on
demand of host system
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This configuration is compliant with Entis Pro or any other modbus host
system. By issuing the appropriate Modbus command, Entis Pro can
demand to switch over to the secondary CIU 888 if the primary CIU 888
is not responding anymore and move to Com2/Port 42 to acquire tank
data. The secondary CIU 888 becomes the active CIU and its host port
becomes R/W.

NOTE: Refer to the chapter ‘CIU Plus Links’ in the Configuration Manual Entis Pro
2.80x for Windows (Part No. 4416381) for more information about connecting
the CIU 888 to the Entis Pro system. 

C.11.2 RS-232 host port redundancy with redundant CIU 888s and data synchro-
nization between host systems

In this configuration, each CIU 888 in the redundant configuration is
connected to a separate host system, for example, Entis Pro (see
FIGURE C-7). The CIU 888s are connected to the host system via one
of their fixed Host ports. Each host port has its own unique RTU address
and is configured for communication through Modbus RTU on serial. By
connecting each CIU 888 to a separate instance of Entis Pro, an extra
safety is created in the event of failure of one of the two host systems. 

FIGURE  C-7 RS-232 host port redundancy with redundant pair of CIU 888s and data synchronization
between host systems



Appendix C - Redundancy

Part No.: 4417584_Rev12 Configuration Manual
CIU 888 C - 16

This configuration is compliant with Entis Pro or any other modbus host
system. By issuing the appropriate Modbus command, Entis Pro can
demand to switch over to the secondary CIU 888 if the primary CIU 888
is not responding anymore and move to Com2/Port 42 to acquire tank
data. The secondary CIU 888 becomes the active CIU and its host port
becomes R/W.

NOTE: Refer to the chapter ‘CIU Plus Links’ in the Configuration Manual Entis Pro
2.80x for Windows (Part No. 4416381) for more information about connecting
the CIU 888 to the Entis Pro system. 

C.11.3 Modbus TCP host port redundancy with redundant CIU 888s and data 
synchronization between host systems

In this configuration, both CIU 888s in the redundant configuration are
connected to the Honeywell Experion PKS ((see FIGURE C-8)) and to
other Modbus TCP/IP hosts. The CIU 888s are connected to Experion
FTE Networks via FTE A & FTE B ports. CIU 888s acts as non-FTE
nodes on FTE network. Each ethernet port has its own unique IP
address and is configured in Modbus TCP/IP hosts for communication.
Also, LAN ports can be connected to LAN network which can further be
accessed by other Modbus TCP/IP client host systems.
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At CIU 888 level, Modbus maps are created with Unique Unit ID which
can be configured in Modbus TCP/IP Client host systems. This way,
each configured map can be accessed in any Modbus TCP/IP ports.

FIGURE  C-8 Modbus TCP host port redundancy with redundant CIU 888s and data synchronization
between host systems 
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C.11.4 OPC UA TCP host port redundancy with redundant CIU 888s and data 
synchronization between host systems

In this configuration, both CIU 888s in the redundant configuration are
connected to the Honeywell Experion PKS ((see FIGURE C-8)) and to
other Modbus TCP/IP hosts. The CIU 888s are connected to Experion
FTE Networks via FTE A & FTE B ports. CIU 888s acts as non-FTE
nodes on FTE network. Each ethernet port has its own unique IP
address and is configured in Modbus TCP/IP hosts for communication.
Also, LAN ports can be connected to LAN network which can further be
accessed by other Modbus TCP/IP client host systems.
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FIGURE  C-9 OPC UA TCP host port redundancy with redundant CIU 888s and data synchronization
between host systems 
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C.12 Redundant CIU 888-Experion PKS Integration

Redundant CIU 888 and Experion PKS Integration requires necessary
configuration changes in CIU 888 using Service tool and in Experion
PKS using Quick Builder.

C.12.1 Configuring CIU 888

Perform the below steps for the required CIU 888 configuration using
CIU 888 Service tool:

1. On CIU 888 node, click FTE A port.
2. By default, the FTE tab appears displaying the Properties details.
3. Enter appropriate details in the IP address and Modbus port

number fields.
4. Select the Tranparency Mode and IP switch over decision maker

check boxes and click Apply.

5. Click Secondary FTE Host Port tab to view the Properties details.

6. Enter an appropriate IP address in the Secondary’s IP address
field. (For example, if configured Primary CIU 888's IP address is
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given as 10.79.212.182 then the configured Secondary's IP address
can be given as 10.79.212.184)

7. Click Apply.
8. On CIU 888 node, click FTE B port.
9. By default, the FTE tab appears displaying the Properties details.

10. Enter appropriate details in the IP address and Modbus port
number fields.

11. Select the Tranparency Mode and IP switch over decision maker
check boxes and click Apply.

12. Click Secondary FTE Host Port tab to view the Properties details
13. Enter an appropriate IP address in the Secondary’s IP address

field. (For example, if the configured Primary CIU 888's IP address is
given as 10.79.212.183 then the configured Secondary's IP address
can be given as 10.79.212.185). 

CIU 888 is now configured for Experion PKS integration.

NOTE: When Redundant CIU 888 is integrated with Experion PKS, the IP address of
the FTE A & FTE B should be configured in the same subnet. 

C.12.1.1 Configuring Modbus maps

Configure Modbus maps in CIU 888 for Experion PKS based on the site
requirement.   Refer to Configuration manual section 3.2.14 for more
information on Modbus maps configuration procedures. 
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C.12.2 Configuring Experion PKS

Perform the below steps for the required Experion PKS configuration
using Quick builder in Configuration Studio.

1. On the CIU 888A node, click Channels.
2. Under the Main tab, enter details in the Name and Description

fields.
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3. Under the Port tab, choose LANVendor from the Port Type drop-
down list and Modbus TCP from the Network Type drop-down list.

4. Under the Redundant Port tab, choose RedundantLANVendor
from the Port Type drop-down list and Modbus TCP from the
Network Type drop-down list.
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C.12.2.1 Configuring Modbus Controllers

Create Modbus Controller for different type of data inputs and outputs
based on the site requirement. 

For example, for Holding Registers which are required for calculated
and measured parameters, a Modbus Controller "ANALOG" is created
as below and associated with configured Modbus Channel which is CIU
888_TCP. The IP Address 1 and IP Address 2 are configured with
Primary CIU 888's FTE A and FTE B IP address.

For example, if Primary CIU 888's FTE A IP address is 10.79.212.182
and FTE B IP address is 10.79.212.183, then configure IP Address 1 as
10.79.212.182 & IP Address 2 as 10.79.212.183. Also, configure the
port numbers as per the CIU 888 FTE A/FTE B configurations.   

PLC Station ID should be configured based on the Unit ID selected for
Modbus map created in CIU 888 for Experion PKS integration. For
example, if the Modbus map for Experion PKS is created with Unit ID as
1, then PLC Station ID should be configured as 1.

ANALOG modbus controller for holding registers is shown in the figure
below.

Similarly, for Digital Inputs (or Read Discrete Inputs) "INPUT" controller
is created and for Digital Outputs (Write Coils) "OUT" controller is
created and downloaded to server.
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Digital Input Controller for Read Discrete Inputs is as shown in the figure
below.

Digital Output Controller for Write Coils is as shown in the figure below.
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C.12.3 Configure Modbus Points

Based on the Datatypes and Function codes, different points can be
created which can be associated to the Modbus Controllers configured
earlier. 

C.12.3.1 Point configuration for Host initiated switchover

CIU 888's redundancy is controlled by host initiated switchovers.
Hence, the following configuration needs to be done in Experion PKS to
initiate switchovers. 

C.12.3.2 Configure Digital Output Points (Switchover Command)

For the Switchover command, a Status point
SWITCHOVERCOMMAND needs to be created in Quick Builder and
associate to OUTPUT controller created in step 2.2.3.

The PV Source address is given as OUTPUT 1(where OUTPUT is
Controller and 1 indicates the Modbus address of Coil Output to initiate
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as switchover command in CIU 888). Then configure Source and
Destination Address as OUTPUT 1 and download the point to server. 

C.12.3.3 Configure Digital Input(Hotstandby Status)

HOTSTANDBYSTATUS is a Digital Input created for getting the
Hotstandby Status of CIU 888. This is associated to the INPUT
controller and the PV Source Address is given as INPUT 1 (where
INPUT  indicates the Controller & 1 indicates the Modbus address of the
Hotstandby status of CIU 888). 
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Configure Number of States as 2 and configure state Descriptors as
State 1="ON" and State 0="OFF". This will be used in Server scripting
for executing automatic switchover from Experion PKS. 

In the Scripts Tab under HOTSTANDBYSTATUS status point, click on
Create New or Edit existing server scripts. 

"Configure Event as OnChange.

"Configure Script Engine as Automatically Allocate 

"Configure Parameter as PV.

"Copy the below script to the script editor. 

if ucase(ParamValue("HOTSTANDBYSTATUS.PV"))= ucase("ON")
then

ParamValue("SWITCHOVERCOMMAND.OP")= ucase("ON")  

end if

NOTE: This script will check the Hotstandby Status periodically 
(HOTSTANDBYSTATUS.PV) and whenever it changes to ON (which indicates 
CIU 888 as PASSIVE), a switchover command 
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(SWITCHOVERCOMMAND.OP=ON) is issued to CIU 888 so that the CIU 888 
becomes ACTIVE. 

For the Write Coil for giving Switchover command to CIU 888 to make
ACTIVE in-case of PASSIVE state, a SWITCHOVERCOMMAND.OP is
created which is associated to OUTPUT controller. The PV Source
Address is given as OUTPUT 1 which needs to configured in control tab
of the point for write.

C.12.4 Configure Points for CIU 888 parameters:

Configure the required points for CIU 888 parameters in Experion PKS. 

For example, for Product Level (PL) which is a holding register, under
points in Quick Builder > Add Item>Item Type- Analog point is created
with name "PL". This is associated to the ANALOG controller and the
address format is selected based on EPKS standard format (eg: for 32
signed integer the address format is S32BB, so the PV Source Address
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is configured as ANALOG 27 S32BB. In this example Product Level is
available at Modbus address 26 in CIU 888).

NOTES: 1. For more information on datatype conversion in Experion PKS, refer to 
Knowledge Builder of Experion PKS.

2. After configuration of all required points, enable configured Modbus channel 
and Modbus controllers in Experion PKS station. 

3. Ensure that the created Server Script engine is in Running state in Experion 
PKS station.
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APPENDIX D TANK CAPACITY TABLE

Refer to the below table for the Tank Capacity Table format.

Strap File Example Description
[TANK_ID] [Tank Identification]

Name = TNK-03 ASCII string: the name of the tank

Date = 15-Feb-15 ASCII string: the date this file is 
generated

Time = 12:34:00 PM ASCII string: the time this file is 
generated

Level = 2 1 = m xxx.xxxx
2 = mm xxxxxx.x
3 = ft xxx.xxxx
4 = in xxxx.xxx
5 = in/16 xxxxxx.x

Volume = 51 50 = l xxxxxxxxx
51 = m3 xxxxxx.xxx
52 = USgal xxxxxxxx.x
53 = bbls xxxxxxx.xx

Ullage = 0 0 = innage
1 = ullage

Straps = 6 Number of straps

[STRAPS] [Strap data (level vs. volume)]

1 = -233.0 first (and lowest) strap

2 = 100.0

3 = 1006.3

4 = 2001.7 10732.000

5 = 10032.0 52721.000

6 = 20531.4 98321.000 last (and highest) strap

[KSISTRAPS] KSISTRAPS section is optional. It 
is required only if RIC is 
configured.In case of water strap 
table KSISTRAPS section is not 
required.

1 = 0.168 -

2 = 0.333 -

3 = 0.950 -

4 =  1.843 -

5 = 2.277  27.3562

6 =  4.064 27.3999

[EOF] [End Of File]



Appendix D - Tank Capacity Table

Part No.: 4417584_Rev12 Configuration Manual
CIU 888 D - 32

This format is same for Tank TCT and Water TCT

This page is intentionally left blank
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APPENDIX E DENSITY TABLE FORMAT

Refer to the below table for the Density Table format.

NOTE: This table supports up to 1000 density points.

Density File Example Description
[PRODUCT_ID]

Name =  Petrol ASCII string: the name of 
the Liquid

Date = 01-06-92 ASCII string: the date this 
file is generated

Time = 11:05:16 ASCII string: the time this 
file is generated

Temperature = 20

Density = 60

DensityPoints = 174

[DENSITY_POINTS]

1 = 4,4 1054,2449

2 = 5,0 1053,9333

3 = 5,6 1053,6098

4 = 6,1 1053,2863

5 = 6,7 1052,9747

6 = 7,2 1052,6512

7 = 7,8 1052,3277

8 = 8,3  1052,0161

. . . .

. . . .

. . . .

. . . .

. . . .

50 = 31,7 1038,5956

[EOF] [End Of File]
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APPENDIX F CTL TABLE FORMAT

Refer to the below table for the CTL Table format.

NOTE: This table supports up to 1000 CTL points.

CTL Table Example Description
[PRODUCT_ID]

Name =  Petrol ASCII string: the name of 
the Liquid

Date = 01-06-92 ASCII string: the date this 
file is generated

Time = 11:05:16 ASCII string: the time this 
file is generated

Temperature = 20

CTL = 6

CTLPoints = 50

[CTL_POINTS]

1 = 15.556 2.0000

2 = 16.111 0.9998

3 = 16.667 0.9995

4 = 17.222 0.9992

5 = 17.778 0.9989

6 = 18.333 0.9987

7 = 18.889 0.9984

8 = 19.444 0.9982

. . . .

. . . .

. . . .

. . . .

. . . .

50 = 42.778 0.9873

[EOF] [End Of File]
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APPENDIX G CONCENTRATION TABLE FORMAT

Refer to the below table for the Concentration Table format.

Concentration Table Example Description
[PRODUCT_ID]

Name =  Petrol ASCII string: 
the name of 
the Liquid

Date = 01-06-92 ASCII string: 
the date this 
file is 
generated

Time = 11:05:16 ASCII string: 
the time this 
file is 
generated

Temperature = 20

Concentration = 140

Density = 60

TemperatureCount = 12

ConcentrationCount = 7

[DENSITY_POINTS]

ColVals =  4,0 4,1 4,2 4,3 4,4 4,5 4,6 -

1 = 25,0 NaN NaN 1055,67 1055,57 1055,47 1055,37 1055,27 -

2 = 25,5 NaN NaN 1055,17 1055,07 1054,97 1054,87 1054,77 -

3 = 26,0 NaN NaN 1054.67 1054.57 1054.57 1054,47 1054,37 -

4 = 26,5 NaN NaN 1054,27 1054,17 1054,07 1053,97 1053,87 -

5 = 27,0 NaN NaN 1053,77 1053,67 1053,57 1053,47 1053,37 -

6 = 27,5 NaN NaN 1053,27 1053,17 1053,07 1052,97 1052,87 -

7 = 28,0 NaN NaN 1052,77 1052,67 1052,57 1052,47 1052,37 -

8 = 28,5 NaN NaN 1052,27 1051,17 1051,07 1050,97 1050,87 -

9 = 32,5 1050,77 1050,67 1050,57 1050,47 1050,37 1050,27 1050,17 -

10 = 36,5 1050,07 1049,97 1049,87 1049,77 1049,67 1049,57 1049,47 -

11 = 38,5 1049,37 1049,27 1049,17 1049,07 1048,97 1048,87 1048,77 -

12 = 40,5 1048,67 1048,57 1048,47 1048,37 1048,27 1048,17 1048,07 -

[EOF] - - - - - - - - - [End Of File]
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NOTE: This is in format of a table. Temperature are recorded in rows and
concentration in columns. Density is updated for corresponding temperature
and concentration. NaN is used to indicate not applicable.

NOTE: This table supports up to 1000 temperature points and 200 concentration
points
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APPENDIX H CREATION OF NEW MODBUS FIELD DEVICE / TRL/2 FIELD 
DEVICE CONFIGURATION FILE

Based on the Modbus field device / TRL/2 field device manufacturer's
datasheet, the user shall create the Modbus field device / TRL/2 field
device configuration file according to the attached Modbus field device
configuration template.

Refer to the following sections for more information on the Modbus field
device / TRL/2 field device configuration template.

H.13 Device Type

The following table provides more information on the Device Type.

H.14 Device engineering units

The following table provides information on the various engineering
units supported by the Modbus field device.

XML Tag Description Possible Values
<DeviceInformation>
  <DeviceType>

This is the Modbus field device 
type. The user shall provide 
the device type name like 
SLG700, E+H ProServo etc.

Any string

<IsGPUFlexconnValid> This is specific to TRL/2 device 
and not applicable for Modbus 
device. The user can provide 
"TRUE" for Honeywell TRL/2 
devices and "FALSE" for third 
party devices.

TRUE/FALSE

XML Tag Description Possible Values
<DeviceInformation>
  <DeviceUnits>
    <Unit>
      <Type>

This specifies the Device unit 
type.

LEVEL
TEMPERATURE
DENSITY
PRESSURE 



Appendix H - Creation of new Modbus field device / TRL/2 Field Device 

Part No.: 4417584_Rev12 Configuration Manual
CIU 888 H - 42

H.15 Valid Register Ranges

The following table indicates the valid consecutive Modbus register
address ranges in the device.

H.16 Modbus Map

The following table indicates the Modbus register map of the device that
can be scanned by CIU.

<DeviceInformation>
  <DeviceUnits>
    <Unit>
      <UnitDetail>
        <UnitName>

This specifies the device 
engineering unit. Refer to 
section H.19 for the supported 
units.

For LEVEL : m, cm, 
mm, ft, yard, in, in/16, 
fis, fii/256, in/256, 
1/10 mm (TRL/2)

For TEMPERATURE : 
°C, °F, K, Tenth 
Fahrenheit (TRL/2), 
Tenth Celsius (TRL/2)

For DENSITY : kg/m³, 
°API, lb/ft³, RD60, lb/ 
US gal, kg/l, gr/ml

For PRESSURE : kgf/
cm², Pa, kPa, psi, atm, 
bar, psi_r100, 
psi_r1000, mBarG 
(TRL/2), mBarA (TRL/
2), 1/100 psiG (TRL/
2), 1/100 psiA (TRL/2)

<DeviceInformation>
  <DeviceUnits>
    <Unit>
      <UnitDetail>
        <Resolution>

This specifies the device 
engineering unit's resolution.

-127 to 128

XML Tag Description Possible Values
<ValidRegisterRanges>
  <Range>
    
<StartRegisterAddress>

This indicates the Modbus 
Start address

300001 to 365535
400001 to 465535

<ValidRegisterRanges>
  <Range>
    <EndRegisterAddress>

This indicates the Modbus End 
address

300001 to 365535
400001 to 465535

XML Tag Description Possible Values
<DeviceInformation>
  <ModbusMap>
    <Name>

This indicates the name of 
the parameter in the Modbus 
field device which needs to 
be scanned by CIU.

Any String

XML Tag Description Possible Values
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<DeviceInformation>
  <ModbusMap>
    <ModbusRegisterAddress>

This indicates the relative 
Modbus address of a 
parameter in the Modbus 
field device.
Absolute Modbus address of 
Parameter 
                = Device Modbus 
Start Address + Modbus 
Register Address

This is the 6 digit Modbus 
Register address of the 
device parameter. The first 
digit indicates the Modbus 
function code (3 for Input 
registers and 4 for Holding 
registers). Second to Sixth 
digits indicates the Modbus 
register address defined by 
the device manufacturer. 0 
to 65535 registers can be 
addressed. For example to 
address holding register 0 in 
device, 400001 would be set 
here.

300001 to 365535 
400001 to 465535

<DeviceInformation>
  <ModbusMap>
    <NoofModbusRegisters>

This indicates the number of 
Modbus registers defined for 
the selected parameter.

1 to 125

<DeviceInformation>
  <ModbusMap>
    <ModbusDataType>

The data can be exposed in 
different data types by 
different Modbus field 
devices. This parameter 
indicates the Modbus data 
type in which data is 
exposed by the field device 
so that CIU can interpret the 
data accordingly and convert 
it to its internal data format.
Refer to section H.18 for the 
list of supported Modbus 
data types.

Not a number
Fixed number
ASCII string
Unicode string
8-bit unsigned 
integer
8-bit signed integer
16-bit unsigned 
integer
16-bit signed 
integer
16-bit decimal float
12-bit signed 
integer
32-bit signed 
integer
32-
bit float (regular)
32-bit uint/f1
32-bit uint/f10
32-bit uint/f100
32-bit uint/f1000
32-bit uint/f10000

XML Tag Description Possible Values
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<DeviceInformation>
  <ModbusMap>
    <ByteOrder>

This indicates the byte (8-
bit) order within a 16-bit 
word in which data is 
exposed by the field device. 
There can be 2 formats in 
which data can be exposed 
(i) LSB first (ii) MSB first. 
Based on this configuration 
CIU interprets the data and 
converts it to its internal data 
format.
Note: This refers the 
endianess of the received 
data at byte level. LSB first 
refer to Little Endian and 
MSB first refers to Big 
Endian.

LSB_First
MSB_First

<DeviceInformation>
  <ModbusMap>
    <WordOrder>

This indicates the word (16-
bit) order within a 32-bit long 
word in which data is 
exposed by the field device. 
There can be 2 formats in 
which data can be exposed 
(i) LSW first (ii) MSW first. 
Based on this configuration 
CIU interprets the data and 
converts it to its internal data 
format.
Note: This indicates the 
endianess of the received 
data at word level. LSW first 
refer to Little Endian and 
MSW first refers to Big 
Endian. 

LSW_First
MSW_First 

<DeviceInformation>
  <ModbusMap>
    <Scaling>

Some Modbus field device 
scales the data it exposes to 
the Modbus host. Hence this 
parameter indicates the 
scaling factor used in the 
exposed data from the field 
device so that CIU can de-
scale the retrieved value.

If Scaling and offset are not 
applicable then this tag can 
be left empty

Any float value

XML Tag Description Possible Values
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<DeviceInformation>
  <ModbusMap>
    <Offset>

Some Modbus field device 
adds an offset to the data it 
exposes to the Modbus host. 
Hence this parameter 
indicates the offset factor 
used in the exposed data 
from the field device so that 
CIU can subtract the offset 
from the retrieved value.

If Scaling and offset are not 
applicable then this tag can 
be left empty

Any 32-bit signed 
value

<DeviceInformation>
  <ModbusMap>
    <ScanPriority>

This indicates the default 
scanning priority for a device 
parameter. This can be 
configured as Foreground / 
Background. While scanning 
the field device, if multiple 
field device parameters are 
retrieved in one Modbus 
request, then highest priority 
within the scanned field 
device parameters is set for 
that request. 
For example, if Product 
Level (Foreground priority), 
Product Temperature 
(Background priority), 
Product Density 
(Background priority) are 
retrieved from the field 
device with a single Modbus 
request, then the Modbus 
request would be scheduled 
to the field with Foreground 
priority.

This can be overridden 
through Modbus Data Input 
configuration in CIU 888 
service tool.

FOREGROUND
BACKGROUND

<DeviceInformation>
  <ModbusMap>
    <DeviceUnitType>

This indicates the device 
unit type of the parameter 
configured in the Modbus 
field device.

If value for this tag is set as 
"ANY" then CIU 888 service 
tool shall display all the 
device supported units in its 
User Interface for this 
parameter in Modbus Data 
Input configuration.

LEVEL
TEMPERATURE
DENSITY
PRESSURE
ANY

XML Tag Description Possible Values
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<DeviceInformation>
  <ModbusMap>
    <DeviceUnitName>

This indicates the default 
device unit of the parameter 
configured in the device.

Supported Values are based 
on DeviceUnits section.

For LEVEL : m, 
cm, mm, ft, yard, 
in, in/16, fis, fii/
256, in/256, 1/10 
mm (TRL/2)

For 
TEMPERATURE : 
°C, °F, K
Tenth Fahrenheit 
(TRL/2), Tenth 
Celsius (TRL/2)

For DENSITY : kg/
m³, °API, lb/ft³, 
RD60, lb/ US gal, 
kg/l, gr/ml

For PRESSURE : 
kgf/cm², Pa, kPa, 
psi, atm, bar, 
psi_r100, 
psi_r1000, mBarG 
(TRL/2), mBarA 
(TRL/2), 1/100 
psiG (TRL/2), 
1/100 psiA (TRL/2)

For ANY : The tag 
shall be empty

XML Tag Description Possible Values
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<DeviceInformation>
  <ModbusMap>
    <FailedValue>

This indicates Modbus field 
device parameter failure 
value. That is, when 
parameter value retrieved 
from Modbus field device is 
equal to this value, it 
indicates the device 
parameter value is in failure. 
For example, if 
0xFFFFFFFF represents 
Product level measurement 
failure for a Modbus field 
device, then when CIU 
receives that value it 
interprets that the Product 
level measurement has 
failed and sets the Product 
Level status accordingly.

When status register is 
present in the device (Status 
tag information present), 
status and validity of the 
device parameter would be 
determined by CIU based on 
Status tag in the status 
section and this tag shall be 
empty.

Any HEX string as 
per the Modbus 
field device 
manufacturer.

<DeviceInformation>
  <ModbusMap>
    <Status>
      <Name>

This is the device status 
parameter name as defined 
in the Manufacturer's 
product data sheet.

Any string

<DeviceInformation>
  <ModbusMap>
    <Status>
      <ModbusRegisterAddress>

This indicates the Modbus 
register address of the 
status parameter associated 
with device parameter that 
needs to be scanned by CIU 
888.

This is the 6 digit Modbus 
Register address of the 
device parameter. The first 
digit indicates the Modbus 
function code (3 for Input 
registers and 4 for Holding 
registers). Second to Sixth 
digits indicates the Modbus 
register address defined by 
the device manufacturer. 0 
to 65535 registers can be 
addressed. For example to 
address holding register 0 in 
device, 400001 would be set 
here.

300001 to 365535 
400001 to 465535

XML Tag Description Possible Values
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H.17 Custom Value Map

This configuration defines the value mapping between device
parameter value and CIU parameter value. This configuration would be
defined only if a direct mapping of device parameter value to CIU

<DeviceInformation>
  <ModbusMap>
    <Status>
      < NoofModbusRegisters >

This indicates the number of 
Modbus registers defined for 
the Modbus field device 
status parameter that needs 
to be scanned by CIU 888.

As per Modbus 
field device 
Modbus datasheet

<DeviceInformation>
  <ModbusMap>
    <Status>
      <ModbusDataType>

This indicates the Modbus 
datatype for the Modbus 
field device status parameter 
that needs to be scanned by 
CIU 888.

Not a number
Fixed number
8-bit unsigned 
integer
8-bit signed integer
16-bit unsigned 
integer
16-bit signed 
integer
12-bit signed 
integer
32-bit signed 
integer

<DeviceInformation>
  <ModbusMap>
    <Status>
      <ByteOrder>

This indicates the Modbus 
field device's byte order for 
16 bit status data. Based on 
this configuration, CIU 888 
inteprets the field device 
status value with correct 
byte ordering.
There can be 2 formats in 
which data can be exposed 
(i) LSB first (ii) MSB first. 
Based on this configuration 
CIU interprets the data and 
converts it to its internal data 
format.

LSB_First
MSB_First

<DeviceInformation>
  <ModbusMap>
    <Status>
      <WordOrder>

This indicates the Modbus 
field device's word order for 
32 bit status data. Based on 
this configuration, CIU 888 
interprets the field device 
status value with correct 
word ordering.
There can be 2 formats in 
which data can be exposed 
(i) LSW first (ii) MSW first. 
Based on this configuration 
CIU interprets the data and 
converts it to its internal data 
format.

LSW_First
MSW_First

XML Tag Description Possible Values
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parameter value is not possible. For example, Product level value in
device can be directly mapped to CIU Product level value but Gauge
status / Gauge alarms from the device might not directly map to CIU
Gauge status / Gauge alarms and needs a custom value map. Refer to
the following table for more information.

XML Tag Description Possible Values
<CustomValueMap>
  <CustomValue>
    <DeviceParameterName>

This is the device parameter 
name as defined in the 
Manufacturer's product data 
sheet to which we need to 
associate the custom value.

Any value defined as 
part of 
<DeviceInformation><
ModbusMap>
 <Name> (or) 
<DeviceInformation><
ModbusMap>
<Status><Name>

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <Name>

This indicates the CIU 
Parameter Name to which 
device parameter is mapped.

ProductLevelStatus
ProductTempStatus
WaterMeasuredStatus
DObsHIMSStatus
VapRoomTempStatus
VapRoomPressStatus
AmbientTemperature
Status
GaugeStatus
GaugeLevelAlarms
ExternalContacts

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <ValueMapType>

This indicates the value map 
type.
Device parameter's 
enumeration to CIU 
parameter's enumeration shall 
be specified here.

EnumerationToEnume
ration

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <DefaultValue>

Default Value indicates what 
should be the CIU value if 
EnumerationToEnumeration is 
selected for ValueMapType 
and no mapping defined for a 
particular device parameter 
value

Any value as per CIU 
parameter

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <DeviceParameterStartBitIndex>

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <DeviceParameterEndBitIndex>

This value indicates the 
portion of the device value 
which needs to be copied to 
the CIU parameter.

For example, if Bits 15 to 8 of 
the device parameter needs to 
be copied then BitM = 8 and 
BitN = 15.

If the entire device value 
needs to be copied then this 
tag shall be empty

Any value as per 
Modbus field device 
Modbus datasheet
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H.18 Supported Modbus Data types

Modbus Data types are not standard. Based on the analysis of the
Modbus field devices, the following Modbus data types would be
supported in CIU.

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <CIUParameterStartBitIndex>

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <CIUParameterEndBitIndex>

This value indicates the 
portion in the CIU parameter 
where the device value needs 
to be copied.

For example, if the device 
value needs to copied to Bits 
12 to Bit 8 after value mapping 
is done then it BitM = 8 and 
BitN = 12

If the the device value (after 
value mapping) needs to 
completely replace CIU 
parameter value then this tag 
shall be empty.

Any value as per 
Modbus field device 
Modbus datasheet

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <MapDetail>
        <DeviceParameterValue>

Device Value in Modbus data 
type.

Any value as per 
Modbus field device 
Modbus datasheet

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <MapDetail>
        <CIUParameterValue>

CIU Value in CIU Parameter 
data type.

Any value as per CIU 
parameter

Modbus Data 
Type Description

Not a number This data represents 8 / 16 bit coded information.

Fixed number This data represents a 16 bit fixed number. 

ASCII string The data represents a string of two ASCII characters per 
register.

Unicode string The data represents a string of one UNICODE character per 
register

16-bit unsigned 
integer

The data represents an unsigned integer.
Range : 0 to 65535

16-bit signed 
integer

The data represents an signed integer (in 2’s complement).
Range : -32768 to 32767

XML Tag Description Possible Values
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16-bit decimal 
float

Bit 15       : sign
Bit 14..11 : Exponent power of 10
Bit 10..0   : Mantissa

Value = -1 sign * mantissa * 10 (Exponent - 7)

Range : -1023*E7 to +1023*E7

12-bit signed 
integer

Bit 15..13 : Not used
Bit 12       : 0 – Positive
                  1 – Negative
Bit 11..00 : Value 0 to 4095.

If the sign is negative, the value is shown in 2’s complement.

Range : -4095 to +4095

32-bit signed 
integer

The data represents an signed integer.
Range : + 2147483648 to – 2147483647

32-
bit float (regular)

32 Bit IEEE floating point in TWO registers.
All floating point data is coded into 4 Bytes Floating point.
This format allows a representation of finite numbers from 
negative to positive 3.402823 *E38

Range : -3.402823*E-38 to +3.402823*E38

32-bit uint/f1 Most significant 16 bits represent integer data and least 
significant 16 bits is 0.

Range : 0 to 65535.5

32-bit uint/f10 Most significant 16 bits represent integer data and least 
significant 16 bits represents 1 fraction digit.

Range :  0...65535.95

32-bit uint/f100 Most significant 16 bits represent integer data and least 
significant 16 bits represents 2 fraction digits.

Range : 0...65535.995

32-bit uint/f1000 Most significant 16 bits represent integer data and least 
significant 16 bits represents 3 fraction digits.

Range : 0...65535.9995

32-bit uint/
f10000

Most significant 16 bits represent integer data and least 
significant 16 bits represents 4 fraction digits.

Range : 0...65535.99995

Char This data represents an ASCII character.

8-bit signed 
integer

This data represents an 8-bit signed data.

Range : -127 to 128

Modbus Data 
Type Description
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H.19 Supported Device Engineering Units

Device engineering units are not standard. Based on the analysis of the
Modbus field devices, the following device engineering units would be
supported in CIU.

8-bit unsigned 
integer

This data represents an 8-bit unsigned data.

Range : 0 to 255

Units of 
Measurement 
Type

Device Unit

Level Meters

Millimeters

Tenth Millimeter (TRL/2)

Feet

Inches

Sixteenth of Inch

TwoFiftySixth of inch

Centimeter

Yard

Temperature Celsius

Tenth Celsius

Tenth Fahrenheit

Fahrenheit

Kelvin

Pressure KGF CM SQ

Pascal

Kilo Pascal

PSI

ATM

Bar

mBarG (TRL/2)

mBarA (TRL/2)

1/100 psiG (TRL/2)

1/100 psiA (TRL/2)

PSI RANGE 100

PSI RANGE 1000

Modbus Data 
Type Description
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Density Kilogram cubic meters

Degrees API

Pounds cubic feet

RD60

lbs_us_gallon

kilogram_liters

Gram / Millilitre

Units of 
Measurement 
Type

Device Unit
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APPENDIX I LIST OF ABBREVIATIONS

Abbreviation Description
BPM Bi-Phase Mark

CIU Communication Interface Unit

DCS Distributed Control System

GOV Gross Observed Volume

GPU Gauge Processing Unit

GSV Gross Standard Volume

HTTP Hypertext Transfer Protocol

PC Personal Computer

PLC Programmable Logic Controller

RAM Random Access Memory

RTU Remote Terminal Unit

SCADA Supervisory Control And Data Acquisition

TOV Total Observed Volume

TRL Tank Radar Level

W&M Weights and Measures

XML Extensible Markup Language

LM Legal Metrology
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